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Chapter 1. About This Book
This book describes how to install, configure, and start HCL  Z and I Emulator for Windows. After you get Z and I 

Emulator for Windows  up and running and begin to perform various tasks, use the online help whenever you need 

additional information. See Where to Find More Information  on page 1 for information about online help, the Z 

and I Emulator for Windows  library, and related publications. .

This book is for users of:

• HCL  Z and I Emulator for Windows, Version 3.0

• HCL  Z and I Emulator for Windows  iSeries, Version 3.0

See What's in the Package  on page 1 for information regarding what is in the product package.

In this book, Windows®  refers to Microsoft®  Windows®  7, Windows®  8/8.1, Windows®  10, Windows®  Server 2008, 

and Windows®  Server 2012. When information is applicable only to a specific operating system, this will be indicated 

in the text.

What's in the Package
The Z and I Emulator for Windows  Version 3.0  package contains HCL  Z and I Emulator for Windows, Version 3.0, 

which provides 5250, 3270, and VT emulation and connections to z/OS™, z/VM™, eServer™  i5, System i5™, iSeries™, 

zSeries™  and ASCII host systems.

In addition to the products previously mentioned, the Z and I Emulator for Windows  installation image contains the 

following:

• Adobe Acrobat Reader, to enable you to read softcopy books available on the installation image

• Book files in PDF format

Note:

1. For each of the two basic packaging options, there are also separate installation images, depending 

on:

Security Levels

Z and I Emulator for Windows  is shipped at the 168-bit encryption level.

Where to Find More Information
The following sections discuss getting help when you are installing, configuring, or using Z and I Emulator for 

Windows.
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The Quick Beginnings  book is also available online, in HTML form. You can access the book from the Help  menu in 

the Session Manager.

Information Center
You can find documentation and links to other resources at the Z and I Emulator for Windows  Information Center, at 

the following address:

https://help.hcltechsw.com/zie/ziewin/3.0/index.html

The Information Center  contains reference material that is not found in this book, such as keyboard layouts and host 

code page tables.

Online Help
The help facility describes how to install, configure, and use Z and I Emulator for Windows. Online help is very 

extensive and includes information about every aspect of configuring and using Z and I Emulator for Windows. You 

can use Z and I Emulator for Windows  online help just as you use the online help for Windows®.

Use help to obtain information about:

• Menu choices

• Operation procedures

• Operations in windows

• Meanings of the terms displayed in windows

• Causes of errors and the corresponding actions to take

• Mouse-based operations

• Operation without a mouse

• Detailed explanations of specific terms

• Further technical information about Z and I Emulator for Windows

• Detailed explanations of operator information area (OIA) messages

Z and I Emulator for Windows  Library
The Z and I Emulator for Windows  library includes the following publications:

• Installation Guide

• Quick Beginnings  (this document)

• Emulator User's Reference

• Administrator's Guide and Reference

• Emulator Programming

• Host Access Class Library

https://help.hcltechsw.com/zie/ziewin/3.0/index.html
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• Host Access Class Library

• Configuration File Reference

In addition to the PDF documents, there are HTML documents provided with Z and I Emulator for Windows:

Quick Beginnings

The HTML form of Quick Beginnings  contains the same information as the PDF version. The HTML files 

are installed automatically and can be accessed from the Help menus in the Session Manager and .WS 

session panels.

Contacting HCL
This section lists ways you can reach HCL  in case you encounter a problem or concern with Z and I Emulator for 

Windows. Depending on the nature of your problem or concern, we ask that you be prepared to provide the following 

information to allow us to serve you better.

• The environment in which the problem occurs:

◦ Z and I Emulator for Windows  configuration

▪ Z and I Emulator for Windows  version and manufacturing refresh level

▪ The name of the workstation profile

◦ Workstation configuration

▪ The machine type and model, the system memory, the video adapter

▪ The communication adapter you are using

▪ Other adapters (especially communication adapters) installed

▪ The printer type and model

▪ Other devices installed, such as sound cards, modems, or fax machines

◦ Software configuration

▪ Windows®  version and level

▪ Communication and device-driver version and level

▪ Other communication programs (such as Microsoft®  or Microsoft®  Data Link Control) that are 

running and using resources

▪ Printer driver version and level

◦ Host configuration

▪ The upstream host connection and configuration

• Problem analysis information

◦ Symptoms

◦ Type of problem

◦ OIA messages or error messages (if any)

◦ Key factors related to the problem

If you have a technical problem, take the time to review and carry out the actions suggested here. Use your local 

support personnel before contacting HCL. You can also check the Hints and Tips at the Z and I Emulator for Windows 
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support Web page for more information. Only persons with in-depth knowledge of the problem should contact HCL; 

therefore, support personnel should act as the interface with HCL.

For information about problem analysis tools, refer to Emulators User's Reference  for Z and I Emulator for Windows 

Version 3.0. This reference also provides detailed, specific emulator information about printing, file and data transfer, 

node operations, and other topics.

Managed ZIEWIN and Interoperablity
This section provides detailed information about Managed ZIEWin and Interoperabilty between HCL Z and I Emulator 

for Windows and HCL Z and I Emulator for Web Clients.

HCL Z and I Emulator for Windows uses Session Manager Online dialog to provide easy access to workstation 

profiles and batch files on the ZIE Server. With Session Manager Online users can create or start a single or multiple 

sessions and or batch files. Users can create their own profile to the ZIE server and migrate existing files such as the 

workstation profiles (*.WS) and batch files (*.BCH) that were stored on the ZIE Server.

This "How To" document aims to supplement additional detailed information in setting up Managed HCL Z and I 

Emulator for Windows (ZIEWIN) as referenced below.

Steps to Install Using Managed:

Refer to Planning to Install Z and I Emulator for Windows  on page 25

The steps provided in this document are applicable to all Windows 10 versions which are 64-bit OS level.

Prerequisites :

1. Download a copy of HCL Z and I Emulator for Windows 64-bit base package and HCL Z and I Emulator for 

Windows RP1.zip

2. A HCL Z and I Emulator for Web server is required for the Session Manager Online to work.

3. Create a folder (e.g. MPZiewin) in the ZIEWEB published directory.

4. Unzip and dump the HCL Z and I Emulator for Windows RP1 contents in MPZiewin  folder.

5. Right click the MPZiewin folder > Properties > Sharing > Advance Sharing > Put a check on Share this Folder.

6. Click OK then Close.

7. Repeat steps 5-6 with ZIEWEB folder.

8. Obtain the IP address of the ZIEWEB server and use it at step 2 below.

Follow the steps below in setting up Managed HCL Z and I Emulator for Windows (ZIEWIN):

1. There are two ways to input the ZIE Server configuration details. Choosing to go either way will have the same 

results.

• During the ZIEWIN installation a new panel has been added.



Chapter 1. About This Book

• Preferences Manager - Click on Start > HCL Z and I Emulator for Windows > Preferences > Advanced
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2. Enter the configuration parameters based on the information below:

• Web Server URL : The URL of the Web Server from where HCL Z and I Emulator for Windows fix pack 

file will be downloaded for installation. Installer or fix pack will be installed on the system by "Start or 

Configure Sessions - Online" program.>

• Config Server : URL of the Application Server/Embedded Server, on which interoperability module (.war 

file) is deployed. It can be deployed on the HOD Embedded Server or on any configured Application 

Server.

Example: http://< Application Server IP >/<Configured context root of the application>

For more details on WAR file deployment, refer to the technote <hyper-link>.
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• Config Server Port : Port number of Application Server where interoperability module (.war file) is 

deployed.

Example: 9080

3. Click OK.

4. Open File Explorer > This PC > Map network drive.  Use the IP address of the Web Server along with the folder 

where the HCL Z and I Emulator for Windows RP1.msi is located. E.g. \\192.168.56.102\MPZiewin

5. Click Save.

6. Repeat steps 4-5 with ZIEWEB folder. E.g. \\192.168.56.102\ZIEWEB

Note:  This completes configuring Managed HCL Z and I Emulator for Windows (ZIEWIN).

7. To validate that the configuration is correct, create a new Username or use an Existing User in the Session 

Manager Online. Click on Start > HCL Z and I Emulator for Windows > Start or Configure sessions - Online

Points to consider:

• When mapping the network drive ensure that client machine and ZIEWEB server is within the same network.

• The Session Manager Online checks for updates at startup. It is essential that HCL Z and I Emulator for 

Windows RP1 is in the ZIEWEB published directory.

Interoperability between HCL Z and I Emulator for Windows and HCL Z and I 
Emulator for Web Clients
The interoperability feature allows the ZIEWin users to use the ZIEWin sessions from other HCL terminal emulator 

clients, such as ZIEWeb and ZIEWeb Client. ZIEWin users can use the “Session Manager Online” utility to store the 

new sessions and migrate the existing sessions to ZIE server, these sessions are then converted to ZIEWeb Session 

formats for the ZIEWeb and ZIEWeb Client usage.
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Note:  Interoperability feature is introduced in ZIEWin 2.1 version.

ZIEWin client communicates with the ZIE server over HTTP/HTTPS connectivity using JSON data format.

The interoperability feature is supported from ZIEWeb v2.1.0.0 & ZIEWeb Client v2.1.0.0 onwards and is applicable for 

3270 Display, 5250 Display, 3270 Printer, 5250 Printer, and VT sessions.

Note:  The session conversion happens only for ZIEWin to ZIEWeb sessions and not vice versa.

When the user stores the ZIEWin sessions using the “Session Manager Online” utility, they are converted to ZIEWeb 

sessions before saving them to the ZIE server . After storing to the ZIE server , users can log in from ZIEWin, ZIEWeb, 

or ZIEWeb Client to work with the stored ZIEWin sessions.

Using ZIEWin Sessions from ZIEWeb and ZIEWeb  Client:

After the ZIEWin sessions are stored in the ZIE server , if any changes are made to the session definition from any of 

the clients, it is saved in the ZIE server . These session changes will be available to ZIEWin users after the next login.

Below is the list of supported parameters as part of the Interoperability feature.

Table  1. List of Supported Parameters for Interoperability

ZIEWIN Parameter ZIEWEB Parameter

Primary Host Name or IP Address Destination Address

Primary Port Number Destination Port

Primary LU or Pool Name LU or Pool Name

Screen Size Screen Size

Host Code-Page Host Code-Page

Auto-reconnect Auto-reconnect

Backup 1 Host Name or IP Address Backup 1 Destination Address

Backup 2 Host Name or IP Address Backup 2 Destination Address

Backup 1 Port Number Backup 1 Destination Port

Backup 2 Port Number Backup 2 Destination Port

Backup 1 LU or Pool Name Backup 1 LU or Pool Name

Backup 2 LU or Pool Name Backup 2 LU or Pool Name

Enable Security Protocol

Workstation ID Workstation ID

Server Authentication Server Authentication

Message Queue Message Queue

Message Library Queue Library

Send Personal Certificate to Server if it is Requested Send a Certificate

Send Personal Certificate Trusted by Server Certificate Source

Send Personal Certificate Based on Key Usage Enable Key Usage

Machine Mode Terminal Type (VT session)
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Table  1. List of Supported Parameters for Interoperability  (continued)

ZIEWIN Parameter ZIEWEB Parameter

AutoWrap AutoWrap (VT session)

Note:  Only the listed parameters will be modified from ZIEWeb / ZIEWeb Client for a ZIEWin profile. If any 

other parameters are updated from ZIEWeb / ZIEWeb Client, there will not be any changes to the ZIEWin 

session. Users should modify the ZIEWin sessions either from ZIEWin or ZIEWeb / ZIEWeb Client at a time 

and should avoid simultaneous modifications from different clients.

Interoperability 2.1.0.0 Configuration Introduction:

ZIEWeb v3.0 (from v2.1.0.0 onwards) introduced interoperability between ZIEWin and ZIEWeb. This allowed ZIEWin 

sessions to be accessed through ZIEWeb and ZIEWeb Client after the session definitions were uploaded to the ZIE 

server .

Password provided during the user creation will be encrypted using AES 128-bit algorithm and will be sent to the 

server through the HTTP/HTTPS protocol as Json object. UID is added to the WS and BCH profile files for unique 

identification. Only Connection parameters are considered for the interoperability between ZIEWin and ZIEWeb Clients 

and vice-versa.

After the ZIEWin sessions are converted and stored in the ZIE server , any changes made to the common parameters 

from any of the clients will be saved on the ZIE server . These parameter changes will be available to ZIEWin users 

after the next login.

Steps to install:

1. Install the ZIEWeb v3.0.

2. Install the ZIEWin v3.0

WAR File Configuration:

The interoperability executable (ZIEWeb_Interoperability.war) is available under the lib directory of the product.

For Embedded Web Server:

If the Embedded Web Server is used, by default Interoperability application is running on context root "interop”. If 

the user needs to change the context root, add the following parameter to the configuration file (config.properties), 

located in the ZIE server publish directory.

Example: InterOpContextPath=interop

The default ZIE server IP is 127.0.0.1 and the ZIE server port is 8999. If the user needs to connect to the ZIE server 

located on a different machine, then override the interoperability configuration by modifying the properties of 

“interop_overrides.xml”  in the conf directory under the lib directory of the product.

Table  2.  List of properties that can be used to configure the Interoperability

Property Value Description

ZIEWEB_SERVER_IP 127.0.0.1 ZIE server address
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Table  2.  List of properties that can be used to configure the Interoperability  (continued)

Property Value Description

ZIEWEB_SERVER_PORT 8999 ZIEWEB Config Server port

Directory_Location C:\\dir_location Directory Location for logs

The user can utilize ZIEWeb_Interoperability.war  file (available under the lib directory of the product) to deploy to 

different application servers such as WAS/Tomcat.

For WebSphere Application Server (WAS):

1. Log in to WebSphere Application Server.

2. Go to Applications.

3. Click WebSphere enterprise applications under Application Type.

4. Select ZIEWeb_Interoperability.war file.

5. Click on Initialize parameters for servlets link under Web Module Properties  section.

6. Enter the required values.

Supported Application Servers: Apache Tomcat and WAS.

Limitations

1. Only connection parameters are considered for interoperability between ZIEWin and ZIEWeb and vice-versa.

2. Session creation from ZIEWeb / ZIEWeb Client will not be converted to a ZIEWin session.

Known Issues

1. For stored ZIEWin sessions, changes to any session parameters (not only the listed parameters) from 

ZIEWeb / ZIEWeb Client will be overridden or set to default when there is an update from “Session Manager 

Online” (ZIEWin Client).

2. If there are simultaneous profile updates from any of the two clients, the most recent update will be saved as 

the final copy in the ZIE server .

3. Modifications done in multiple sessions (add, delete sessions, or rename) from the ZIEWeb Clients do not 

reflect in the ZIEWin Client.

4. Saving/renaming profiles with special characters (Ex: \ / : * ? " < > |.) in ZIEWeb/ ZIEWeb Clients will result in 

unexpected behavior in the ZIEWin Client.

How to setup Managed HCL Z and I Emulator for Windows (ZIEWIN)

HCL Z and I Emulator for Windows uses Session Manager Online dialog to provide easy access to workstation 

profiles and batch files on the ZIE Server. With Session Manager Online users can create or start a single or 

multiple sessions and or batch files. Users can create their own profile to the ZIE server and migrate existing 

files such as the workstation profiles (*.WS) and batch files (*.BCH) that were stored on the ZIE Server.

This "How To" document aims to supplement additional detailed information in setting up Managed HCL Z 

and I Emulator for Windows (ZIEWIN) as referenced below.

Steps to Install Using Managed: Refer to Planning to Install Z and I Emulator for Windows  on page 25



Chapter 1. About This Book

The steps provided in this document are applicable to all Windows 10 versions which are 64-bit OS level.

Prerequisites :

a. Download a copy of HCL Z and I Emulator for Windows 64-bit base package and HCL Z and I Emulator 

for Windows RP1.zip

a. A HCL Z and I Emulator for Web server is required for the Session Manager Online to work.

b. Create a folder (e.g. MPZiewin) in the ZIEWEB published directory.

c. Unzip and dump the HCL Z and I Emulator for Windows RP1 contents in MPZiewin  folder.

d. Right click the MPZiewin folder > Properties > Sharing > Advance Sharing > Put a check on Share this 

Folder.

e. Click OK then Close.

f. Repeat steps 5-6 with ZIEWEB folder.

g. Obtain the IP address of the ZIEWEB server and use it at step 2 below.

Follow the steps below in setting up Managed HCL Z and I Emulator for Windows (ZIEWIN):

There are two ways to input the ZIE Server configuration details. Choosing to go either way will have the same 

results.

• During the ZIEWIN installation a new panel has been added.

• Preferences Manager - Click on Start > HCL Z and I Emulator for Windows > Preferences > Advanced
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a. Enter the configuration parameters based on the information below:

• Web Server URL : The URL of the Web Server from where HCL Z and I Emulator for Windows fix 

pack file will be downloaded for installation. Installer or fix pack will be installed on the system 

by "Start or Configure Sessions - Online" program.>

• Config Server : URL of the Application Server/Embedded Server, on which interoperability 

module (.war file) is deployed. It can be deployed on the HOD Embedded Server or on any 

configured Application Server.

Example: http://< Application Server IP >/<Configured context root of the application>

For more details on WAR file deployment, refer to the technote <hyper-link>.
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• Config Server Port : Port number of Application Server where interoperability module (.war file) 

is deployed.

Example: 9080

b. Click OK.

c. Open File Explorer > This PC > Map network drive.  Use the IP address of the Web Server 

along with the folder where the HCL Z and I Emulator for Windows RP1.msi is located. E.g. \

\192.168.56.102\MPZiewin

d. Click Save.

e. Repeat steps 4-5 with ZIEWEB folder. E.g. \\192.168.56.102\ZIEWEB

Note:  This completes configuring Managed HCL Z and I Emulator for Windows (ZIEWIN).

f. To validate that the configuration is correct, create a new Username or use an Existing User in the 

Session Manager Online. Click on Start > HCL Z and I Emulator for Windows > Start or Configure 

sessions - Online

Points to consider:

• When mapping the network drive ensure that client machine and ZIEWEB server is within the same 

network.

• The Session Manager Online checks for updates at startup. It is essential that HCL Z and I Emulator 

for Windows RP1 is in the ZIEWEB published directory.

Interoperability between HCL Z and I Emulator for Windows and HCL 
Z and I Emulator for Web Clients
The interoperability feature allows the ZIEWin users to use the ZIEWin sessions from other HCL terminal emulator 

clients, such as ZIEWeb and ZIEWeb Client. ZIEWin users can use the “Session Manager Online” utility to store the 

new sessions and migrate the existing sessions to ZIE server, these sessions are then converted to ZIEWeb Session 

formats for the ZIEWeb and ZIEWeb Client usage.
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Note:  Interoperability feature is introduced in ZIEWin 2.1 version.

ZIEWin client communicates with the ZIE server over HTTP/HTTPS connectivity using JSON data format.

The interoperability feature is supported from ZIEWeb v2.1.0.0 & ZIEWeb Client v2.1.0.0 onwards and is applicable for 

3270 Display, 5250 Display, 3270 Printer, 5250 Printer, and VT sessions.

Note:  The session conversion happens only for ZIEWin to ZIEWeb sessions and not vice versa.

When the user stores the ZIEWin sessions using the “Session Manager Online” utility, they are converted to ZIEWeb 

sessions before saving them to the ZIE server . After storing to the ZIE server , users can log in from ZIEWin, ZIEWeb, 

or ZIEWeb Client to work with the stored ZIEWin sessions.

Using ZIEWin Sessions from ZIEWeb and ZIEWeb  Client:

After the ZIEWin sessions are stored in the ZIE server , if any changes are made to the session definition from any of 

the clients, it is saved in the ZIE server . These session changes will be available to ZIEWin users after the next login.

Below is the list of supported parameters as part of the Interoperability feature.

Table  3. List of Supported Parameters for Interoperability

ZIEWIN Parameter ZIEWEB Parameter

Primary Host Name or IP Address Destination Address

Primary Port Number Destination Port

Primary LU or Pool Name LU or Pool Name

Screen Size Screen Size

Host Code-Page Host Code-Page

Auto-reconnect Auto-reconnect

Backup 1 Host Name or IP Address Backup 1 Destination Address

Backup 2 Host Name or IP Address Backup 2 Destination Address

Backup 1 Port Number Backup 1 Destination Port

Backup 2 Port Number Backup 2 Destination Port

Backup 1 LU or Pool Name Backup 1 LU or Pool Name

Backup 2 LU or Pool Name Backup 2 LU or Pool Name

Enable Security Protocol

Workstation ID Workstation ID

Server Authentication Server Authentication

Message Queue Message Queue

Message Library Queue Library

Send Personal Certificate to Server if it is Requested Send a Certificate

Send Personal Certificate Trusted by Server Certificate Source

Send Personal Certificate Based on Key Usage Enable Key Usage

Machine Mode Terminal Type (VT session)
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Table  3. List of Supported Parameters for Interoperability  (continued)

ZIEWIN Parameter ZIEWEB Parameter

AutoWrap AutoWrap (VT session)

Note:  Only the listed parameters will be modified from ZIEWeb / ZIEWeb Client for a ZIEWin profile. If any 

other parameters are updated from ZIEWeb / ZIEWeb Client, there will not be any changes to the ZIEWin 

session. Users should modify the ZIEWin sessions either from ZIEWin or ZIEWeb / ZIEWeb Client at a time 

and should avoid simultaneous modifications from different clients.

Interoperability 3.0 Configuration Introduction:

ZIEWeb v3.0 (from v2.1.0.0 onwards) introduced interoperability between ZIEWin and ZIEWeb. This allowed ZIEWin 

sessions to be accessed through ZIEWeb and ZIEWeb Client after the session definitions were uploaded to the ZIE 

server .

Password provided during the user creation will be encrypted using AES 128-bit algorithm and will be sent to the 

server through the HTTP/HTTPS protocol as Json object. UID is added to the WS and BCH profile files for unique 

identification. Only Connection parameters are considered for the interoperability between ZIEWin and ZIEWeb Clients 

and vice-versa.

After the ZIEWin sessions are converted and stored in the ZIE server , any changes made to the common parameters 

from any of the clients will be saved on the ZIE server . These parameter changes will be available to ZIEWin users 

after the next login.

Steps to install:

1. Install the ZIEWeb v3.0.

2. Install the ZIEWin v3.0.

WAR File Configuration:

The interoperability executable (ZIEWeb_Interoperability.war) is available under the lib directory of the product.

For Embedded Web Server:

If the Embedded Web Server is used, by default Interoperability application is running on context root "interop”. If 

the user needs to change the context root, add the following parameter to the configuration file (config.properties), 

located in the ZIE server publish directory.

Example: InterOpContextPath=interop

The default ZIE server IP is 127.0.0.1 and the ZIE server port is 8999. If the user needs to connect to the ZIE server 

located on a different machine, then override the interoperability configuration by modifying the properties of 

“interop_overrides.xml”  in the conf directory under the lib directory of the product.

Table  4.  List of properties that can be used to configure the Interoperability

Property Value Description

ZIEWEB_SERVER_IP 127.0.0.1 ZIE server address
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Table  4.  List of properties that can be used to configure the Interoperability  (continued)

Property Value Description

ZIEWEB_SERVER_PORT 8999 ZIEWEB Config Server port

Directory_Location C:\\dir_location Directory Location for logs

The user can utilize ZIEWeb_Interoperability.war  file (available under the lib directory of the product) to deploy to 

different application servers such as WAS/Tomcat.

For WebSphere Application Server (WAS):

1. Log in to WebSphere Application Server.

2. Go to Applications.

3. Click WebSphere enterprise applications under Application Type.

4. Select ZIEWeb_Interoperability.war file.

5. Click on Initialize parameters for servlets link under Web Module Properties  section.

6. Enter the required values.

Supported Application Servers: Apache Tomcat and WAS.

Limitations

1. Only connection parameters are considered for interoperability between ZIEWin and ZIEWeb and vice-versa.

2. Session creation from ZIEWeb / ZIEWeb Client will not be converted to a ZIEWin session.

Known Issues

1. For stored ZIEWin sessions, changes to any session parameters (not only the listed parameters) from 

ZIEWeb / ZIEWeb Client will be overridden or set to default when there is an update from “Session Manager 

Online” (ZIEWin Client).

2. If there are simultaneous profile updates from any of the two clients, the most recent update will be saved as 

the final copy in the ZIE server .

3. Modifications done in multiple sessions (add, delete sessions, or rename) from the ZIEWeb Clients do not 

reflect in the ZIEWin Client.

4. Saving/renaming profiles with special characters (Ex: \ / : * ? " < > |.) in ZIEWeb/ ZIEWeb Clients will result in 

unexpected behavior in the ZIEWin Client.

How to setup Managed HCL Z and I Emulator for Windows (ZIEWIN)
HCL Z and I Emulator for Windows uses Session Manager Online dialog to provide easy access to workstation 

profiles and batch files on the ZIE Server. With Session Manager Online users can create or start a single or multiple 

sessions and or batch files. Users can create their own profile to the ZIE server and migrate existing files such as the 

workstation profiles (*.WS) and batch files (*.BCH) that were stored on the ZIE Server.

This "How To" document aims to supplement additional detailed information in setting up Managed HCL Z and I 

Emulator for Windows (ZIEWIN) as referenced below.
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Steps to Install Using Managed:

Refer to Planning to Install Z and I Emulator for Windows  on page 25

The steps provided in this document are applicable to all Windows 10 versions which are 64-bit OS level.

Prerequisites :

1. Download a copy of HCL Z and I Emulator for Windows 64-bit base package and HCL Z and I Emulator for 

Windows RP1.zip

2. A HCL Z and I Emulator for Web server is required for the Session Manager Online to work.

3. Create a folder (e.g. MPZiewin) in the ZIEWEB published directory.

4. Unzip and dump the HCL Z and I Emulator for Windows RP1 contents in MPZiewin  folder.

5. Right click the MPZiewin folder > Properties > Sharing > Advance Sharing > Put a check on Share this Folder.

6. Click OK then Close.

7. Repeat steps 5-6 with ZIEWEB folder.

8. Obtain the IP address of the ZIEWEB server and use it at step 2 below.

Follow the steps below in setting up Managed HCL Z and I Emulator for Windows (ZIEWIN):

1. There are two ways to input the ZIE Server configuration details. Choosing to go either way will have the same 

results.

• During the ZIEWIN installation a new panel has been added.
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• Preferences Manager - Click on Start > HCL Z and I Emulator for Windows > Preferences > Advanced

2. Enter the configuration parameters based on the information below:

• Web Server URL : The URL of the Web Server from where HCL Z and I Emulator for Windows fix pack 

file will be downloaded for installation. Installer or fix pack will be installed on the system by "Start or 

Configure Sessions - Online" program.>

• Config Server : URL of the Application Server/Embedded Server, on which interoperability module (.war 

file) is deployed. It can be deployed on the HOD Embedded Server or on any configured Application 

Server.

Example: http://< Application Server IP >/<Configured context root of the application>
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For more details on WAR file deployment, refer to the technote <hyper-link>.

• Config Server Port : Port number of Application Server where interoperability module (.war file) is 

deployed.

Example: 9080

3. Click OK.

4. Open File Explorer > This PC > Map network drive.  Use the IP address of the Web Server along with the folder 

where the HCL Z and I Emulator for Windows RP1.msi is located. E.g. \\192.168.56.102\MPZiewin

5. Click Save.

6. Repeat steps 4-5 with ZIEWEB folder. E.g. \\192.168.56.102\ZIEWEB

Note:  This completes configuring Managed HCL Z and I Emulator for Windows (ZIEWIN).

7. To validate that the configuration is correct, create a new Username or use an Existing User in the Session 

Manager Online. Click on Start > HCL Z and I Emulator for Windows > Start or Configure sessions - Online

Points to consider:

• When mapping the network drive ensure that client machine and ZIEWEB server is within the same network.

• The Session Manager Online checks for updates at startup. It is essential that HCL Z and I Emulator for 

Windows RP1 is in the ZIEWEB published directory.

19
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Chapter 2. Introduction

Welcome to Z and I Emulator for Windows
Z and I Emulator for Windows  brings the power of personal networking to your workstation  by exploiting networking 

capabilities to provide a variety of connectivity options supporting local area network (LAN) and wide area network 

(WAN) environments. Whether it is for host terminal emulation, client/server applications, or connectivity, Z and I 

Emulator for Windows  offers a robust set of communication, networking, and administrative features.

Z and I Emulator for Windows  is a full-function emulator. In addition to host terminal emulation, it provides these 

useful features:

• File transfer

• Dynamic configuration

• An easy-to-use graphical interface

• Emulator APIs such as Emulator High-Level Language Programming Interface (EHLLAPI), Host Access Class 

Library (HACL), and PCSAPI. For example, EHLLAPI is often used for automated operator applications which 

read host screens and enter keystrokes without direct user intervention. Refer to Emulator Programming  and 

Host Access Class Library  for details.

A variety of application programming interfaces (APIs) are supported by Z and I Emulator for Windows. You can 

create applications that use the peer-to-peer client APIs, which are based on LU 6.2 and provided by Z and I Emulator 

for Windows. These APIs let you simultaneously access and process information on peer workstations.

What's New in Z and I Emulator for Windows
For information on new functions and enhancements in Z and I Emulator for Windows  Version 3.0, refer to https://

help.hcltechsw.com/zie/ziewin/3.0/doc/readme/readme.html.

Z and I Emulator for Windows  Program Icons
When you have installed Z and I Emulator for Windows, the main functions that you can use are displayed as icons. 

Icons are grouped in sub-folders of the HCL  Z and I Emulator for Windows  program folder.

A brief explanation of each function follows:

Start or Configure Sessions

iconsstart or configure sessionssessionsstart or configure sessions, iconSession ManagerUse this icon to bring up the Session Manager. This dialog allows you to start or configure sessions. 

During configuration, you can specify the session type, screen size, LU number, graphics support, the 

type of communication link and its parameters, as well as other information. You can save all this 

https://help.hcltechsw.com/zie/ziewin/3.0/doc/readme/readme.html
https://help.hcltechsw.com/zie/ziewin/3.0/doc/readme/readme.html
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information in a workstation  profile. After saving, you can start the session by just clicking the session 

icon. Authorized users can also create new batch files from this dialog

Start or Configure Sessions Online

iconsstart or configure sessions onlinesessionsstart or configure sessions online, iconSession Manager OnlineUse this icon to bring up the Session Manager Online. This dialog allows you to manage and use the 

online sessions available on ZIE Server. This provides option for auto install of Z and I Emulator for 

Windows  available on ZIE Server.

Administrative and Problem Determination (PD) Aids

Information Bundler

iconsinformation bundlerinformation bundler, iconUse this icon to gather system files and specific trace and log files, as well as registry information, 

such as the software installed or running on a machine. This can also be run from an active session by 

clicking Actions →  Launch →  Information Bundler.

Log Viewer

iconslog viewerlog viewer, iconUse this icon to view, merge, and sort the Z and I Emulator for Windows  message and trace logs. Z and 

I Emulator for Windows  logs errors and informational messages during initialization and operation. This 

can also be run from an active session by selecting Actions →  Launch →  Log Viewer.

Migration Utility

iconsmigration utilitymigration utility, iconUse this icon to migrate your user-class and system-class files and desktop icons to Z and I Emulator 

for Windows  Version 3.0.
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Trace Facility

iconstrace facilitytrace facility, icon Use this icon to turn trace functions on and off and to capture communication protocol information 

that passes between your workstation  and other host systems. You can use traces to resolve 

communication problems. This can also be run from an active session by selecting Actions →  Launch → 

Trace Facility.

Utilities

Note

These programs are provided on an as-is basis without any warranty of any kind, including the warranties of 

merchantability and fitness for a particular purpose which are expressly disclaimed.

iSeries Connection Configuration

Use this icon if you want to define connections to each iSeries™, eServer™  i5, or System i5™  host that will 

use the data transfer function.

Convert Macro

macroconvertUse this icon to convert an existing Z and I Emulator for Windows  macro to an XML or VBScript file.

Data Transfer (iSeries™  only)

Data TransfericonUse this icon to transfer data between a workstation  and an iSeries™, eServer™  i5, or System i5™ 

database.
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Multiple Sessions

Use this icon to create batch files (.BCH), which can specify multiple emulator sessions (workstation 

profiles) or other supported Windows®  programs that you want to start concurrently. You can create an 

icon for each batch file and start the programs just by clicking the icon.

Preferences

Use this icon if you want to set up or change the user preferences, such as changing the user interface 

language.

ZipPrint (3270 only)

printingZipPrintUse this icon to start the ZipPrint program, which allows you to print host system files or screens, 

PROFS®  notes, calendars, and documents, CMS files, and XEDIT workspaces. When started, ZipPrint 

adds an item to the menu bar  of the session window.ZipPrint

FTP Client

Use this icon to start the Z and I Emulator for Windows  FTP client application, which allows files and 

directories upload and download, and directory navigation of local and remote file systems running FTP 

servers.

Z and I Emulator for Windows  Sessions
The sessions that Z and I Emulator for Windows  provides are logical connections enabling communication between 

your workstation  and a host system. The following session types are available:

Display session

Use your workstation  as a display terminal connected to the host system.

Printer session

Use your workstation  printer as a host system printer.types ofsessions

Client/server session

Establish connections that allow peer communications using CPI-C and APPC (LU 6.2).
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Z and I Emulator for Windows  Connections
Z and I Emulator for Windows  supports a variety of connections to the following host systems. Following are the 

icons you will encounter when you begin to configure an emulator session:

zSeries™

iSeries™

ASCII

zSeries Emulator Connections

Table  5. zSeries Emulator Connection Icons

Interface Attachment

LAN Telnet3270

VT-over-Telnet (TCP/IP)

COM port Telnet 3270

VT over Telnet (TCP/IP)
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iSeries Emulator Connections

Table  6. iSeries Emulator Connection Icons

Interface Attachment

LAN Telnet5250 over TCP/IP

VT over Telnet

COM port

ASCII Emulator Connections (SBCS only)

Table  7. ASCII Emulator Connection Icons

Interface Attachment

LAN VT over Telnet (TCP/IP)

COM port VT over Telnet (TCP/IP)

Planning to Install Z and I Emulator for Windows
Z and I Emulator for Windows  supports a wide range of workstations. There are hardware and software requirements, 

as well as memory and storage requirements, to consider when planning the installation of Z and I Emulator for 

Windows.

The following sections describe and list support for monitors, adapters, and keyboards.

For detailed instructions on installing Z and I Emulator for Windows, refer to Installation Guide.
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For instructions to install the HCL ZIE License Manager, refer to Installation of HCL ZIE License Manager, and see the 

topic Configuration of License Manager settings  on page 104 to configure the ZIE License Manager for ZIEWin.

Workstation  Hardware
Z and I Emulator for Windows  supports workstations with the following hardware:

Table  8. Workstation Hardware Support

System units The recommended system unit has an Intel Pentium® microprocessor and access 

to a DVD-ROM drive.

A minimum of 180 MB of fixed drive space is required.

Display monitors All VGA resolution or above display monitors supported by Windows®.

Video adapters All VGA resolution or above video adapters supported by Windows®.

Keyboards • Enhanced keyboard (101-key, 102-key, 104-key)

• Space-saving keyboard

• Microsoft®  Natural keyboard

Printers All printers supported by Windows®  when a PDT file is not used. For more details 

about printers supported in PDT mode, refer to Emulator User's Reference.

Communication adapters LAN, SDLC, COM Port, OEM, and Multiprotocol communication adapters.

Modems All asynchronous modems that use the Hayes AT®  command set and are supported 

by Windows®.

Synchronous (SDLC) modems attached to a multiprotocol adapter (MPA) or SDLC 

adapter.

Workstation Memory Requirements
For Z and I Emulator for Windows  the amount of memory you need depends on several factors, including the 

operating system you are running on, the attachment type, number of sessions, and the use of programming 

interfaces such as Emulator High-Level Language Application Programming Interface (EHLLAPI) and Dynamic Data 

Exchange (DDE).

Host Requirements

Refer to Emulator User's Reference  for information about hardware requirements for host systems.

For all supported Windows operating systems, Java Runtime Environment 1.8 is installed.

Application Data
Application Data is generally defined to be files that contain user preferences or configuration information; an 

application may need some or all of these files to run properly. Z and I Emulator for Windows  uses multiple 

https://help.hcltechsw.com/zie/ziewin/3.0/doc/install/LM_install.html
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configuration files: User Class  files can be stored individually by user profile, while System Class  files are stored in a 

common location.

Table 9: Application Data File Types  on page 27 lists the classifications of some of the most common Z and I 

Emulator for Windows  file extensions.

Table  9. Application Data File Types

User Class System Class

Extension File Type Extension File Type

.ws Workstation Profile .mlg Default Message Log

.bch Multiple Sessions .trc Unformatted Trace

.ini Session Size and Location .tlg Formatted Trace

.pmp Popup Keypad Configuration .cfg FTP Client Configuration

.kmp Keyboard Configuration .pub Client/Host public key

.srl File Transfer List .dat FTP Client data file

.ndc iSeries™  Connection Configuration

.tto iSeries™  Data Transfer Request (Re

ceive)

.tfr iSeries™  Data Transfer Request 

(Send)

.bar Toolbar Setup

.mac Macro

.mmp Mouse Setup

.xlt Translation Table

.cert Certificate

.der Binary DER

Application Data Locations
The location for Application Data is specified during installation of Z and I Emulator for Windows. The following 

tables list the default Application Data locations, based on operating system.

If the [UserProfile]\Application Data location was selected at installation, the following profile paths are used:

Operating System User-Class Directory (Current User)1 System-Class Directory

Windows 7, Win

dows 8/8.1, Win

dows 10, Windows 

Server 2008, Win

dows Server 2012

C:\Users\%USERNAME%\AppData\Roam

ing\HCL\Z and I Emulator for Windows

C:\ProgramData\HCL\Z and I Emulator for 

Windows

1  The FTP Client configuration files are stored in the profile path mentioned above, under the FTP  folder.
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If the All Users\Application Data location was selected at installation, the following profile paths are used:

Operating System User-Class Directory (Current User)1 System-Class Directory

Windows 7, Win

dows 8/8.1, Win

dows 10, Windows 

Server 2008, Win

dows Server 2012

C:\ProgramData\HCL\Z and I Emulator for 

Windows

C:\ProgramData\HCL\Z and I Emulator for 

Windows

1  The FTP Client configuration files are stored in the profile path mentioned above, under the FTP  folder.

ZIEWin Trial Version
The ZIEWin Trial version package allows users to try and evaluate the product for up to 30 days. Trial version licenses 

can be obtained to use this version. Alternatively, users can also use the "Disable License" option to to try the ZIEWIN 

without licensing.

The ZIEWin trial version is supported in both English and Japanese languages.

To request a free trial version, users can visit the following link:

https://www.hcltechsw.com/mainframe-solutions/mainframe-solutions-free-trial?referrer=help.hcltechsw.com

https://www.hcltechsw.com/mainframe-solutions/mainframe-solutions-free-trial?referrer=help.hcltechsw.com
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Configuring Sessions
Z and I Emulator for Windows  saves emulator configuration information to a workstation  profile (.WS). Depending 

on your Z and I Emulator for Windows  configuration, you might have a workstation  profile only or both a workstation 

profile and a configuration file. The workstation  profile can be used later by other Z and I Emulator for Windows 

sessions, or to restart this session.

LDAP

sessionsicons forYou can have an icon created for each workstation  profile. Then you can select the session icon to establish 

communication with the host system using the saved workstation  profile.

Configuring for iSeries™, eServer™  i5, or System i5™

To connect to an iSeries™, eServer™  i5, or System i5™, specific configuration information in the 

workstation  profile must correspond to the information specified at the iSeries™, eServer™  i5, or System 

i5™  system. Refer to the iSeries™, eServer™  i5, or System i5™  configuration examples in Emulator User's 

Reference  for more information about creating display, line, and controller descriptions on the iSeries™, 

eServer™  i5, or System i5™  system.

If you want to configure multiple links, refer to Administrator's Guide and Reference.

Creating a Configuration
To create a new session, use the following procedure:

1. From the Start menu, click Programs →  HCL  Z and I Emulator for Windows  →  Start or Configure Sessions.

2. From the Session Manager dialog, click New Session.

The Customize Communication window  appears.

3. Select the type of host from the Type of Host  drop-down list box.

4. Select the interface you will use from the Interface  drop-down list box.

5. Select the attachment type you want to use from the Attachment  drop-down list box.

6. Click Session Parameters  to modify the session type (display or printer), host code page, and display/

graphics options.

The Session Parameters – 3270, 5250, or ASCII – Host window appears (depending on the host you selected 

in step 3  on page 29). Click OK.

7. Click Link Parameters.

Enter the appropriate information for each page and click Next  to continue. Click Finish  when you are done.
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Based on the attachment type that you have chosen, make your selections for the parameters in the window 

displayed. Click Help  or press F1  to display parameter details. Click OK  when you are finished.

Note:  If your host is configured to support Secure Sockets Layer (SSL) or Transport Security Layer 

(TLS), then click the Security Setup  tab. Refer to Administrator's Guide and Reference  for details on 

configuring session security.

8. Click the Host Definition  tab to configure the Connection Options.

• Select Auto-reconnect  to reestablish an interrupted connection.

• The Connection Timeout  value tells Z and I Emulator for Windows  how long it should wait for 

connection to the host.

• The Try connecting to last configured host infinitely  option is enabled by default. Clear this box if you 

do not want Z and I Emulator for Windows  to automatically and indefinitely wait for acknowledgement 

for a connect request from the last correctly configured server/host.

• Select Telnet keep alive  to send Telnet Keep Alive commands to the host.

• There are two keep alive mechanisms supported: NOP and TIMING-MARK. The Keep Alive Timeout 

value specifies the interval between the keep-alive requests in seconds. The range of values is 30 to 

99999 seconds.

• Select Bypass signon using Kerberos principal  to enable Kerberos authentication. A ticket is 

generated and passed to the iSeries™, eServer™  i5, or System i5™  host during TN5250 negotiation. This 

option is only available for 5250 sessions.

Note:  You must log into a Windows domain in order to use Kerberos authentication. Refer to 

the relevant Microsoft documentation for specific details. Refer to Administrator's Guide and 

Reference  for details about express logon functions.

• Select Bypass signon using Password substitute  to enable the user to bypass the iSeries login screen 

by sending a SHA1 password substitute.

9. To set up printer association, click the Printer Association  tab and do the following:

a. Select Associated Printer Session.

b. Enter the .WS file for the printer that is to be associated with the specific terminal. You can also click 

Browse  to locate the file.

You can also set the following options:

• Select the Start Associated Printer Minimized  check box, if preferred. This option is unavailable until 

an associated printer is selected.

• Select the Automatically close Associated Printer Session with this session  check box, if preferred. 

This option is unavailable until an associated printer is selected.

• Select Associated device name  to associate the display session with any printer device that currently 

exists on an iSeries™, eServer™  i5, or System i5™  host. This option is only available for 5250 sessions.

10. After configuring the session options, click OK  in the Telnet tab panel.

11. Click OK  on the Customize Communication window. The session is displayed automatically.

Save the workstation profile as described in Saving a Workstation Profile  on page 32.
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Creating an FTP configuration

1. Open the FTP client from Start Menu by clicking Start -> HCL  Z and I Emulator for Windows  -> Utilities -> FTP 

Client.

2. Click Communication -> Configuration  from the menu.

3. Choose the options in the Connect  tab.

• Enter the host name or IP address of the FTP server.

• Set the required options from the Connection  group box if the default values are to be changed.

4. Click the Logon  tab.

• Enter the user name and password.

• Enter the Remote/Local Home Directory values so that once the connection is established, the client 

will list these directories you specified.

5. Click the File Transfer  tab and select the appropriate choice for the Transfer mode from the drop-down list. 

Browse and select a Transfer List File if any.

6. Click the SSL  tab to specify the security parameters for Secure FTP. SSL is optional and not enabled by 

default.

• Check Enable Security  to enable the SSL security.

• Select the Security provider for the connection.

• Enter the Channel Security parameters for the connection.

• Select the Client Authentication method from the two options.

7. Click the Runtime Preferences  tab.

• Enter the action to be taken if target file exists during a file transfer.

• Startup Commands enables you to provide a comma-separated list of FTP Command(s) to be 

executed after a successful connection.

• Pass Through Host Certificate Validation allows the FTP client to finish a successful handshake 

bypassing the server certificate validation.

8. Click OK  to close the configuration dialog.

9. Connect to the host by clicking Communication->Connect  or the Connect  button.

Environment variables in workstation profile
In the .WS profile, you can specify environment variables for the paths of the following Z and I Emulator for Windows 

files:

• Bar files (.bar)

• Popup keypad files (.pmp)

• Mouse customization files (.mmp)

• Keyboard map files (.kmp)

The syntax is as follows:

[Toolbar]
BarFile=C:\%USERDIR%\disp.bar
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[Poppad]
DefaultPoppad=C:\%PROFILEDIR%\test.pmp

[Mouse]
DefaultMouse=%ZIEWinPROFILE%\vtpf.mmp

[Keyboard}
DefaultKeyboard=C:\%USERFOLDER%UserMap.kmp

In the above examples, USERDIR, PROFILEDIR, ZIEWinPROFILE, and USERFOLDER are environment variables that you 

specify. See the following example:

USERDIR = profile\toolbarfiles

Saving Configuration Information
This section describes how to save configuration information. The emulator workstation profile, and FTP Client 

configuration information is stored in a .WS, and .CFG file respectively.

Saving a Workstation  Profile
If you save your emulator configuration information, the session will have the same characteristics the next time you 

start it. If you have an icon added to the Z and I Emulator for Windows  folder, you can restart the session with the 

saved configuration information by clicking this icon from the Start menu. You are automatically given the opportunity 

to save your session information when you close a session. However, if you want to save the information at any time, 

use the following procedure:

1. Select Save  from the File menu  in the session window.

The Save WorkStation Profile As  window appears.

2. Type a file name (.WS) and then click OK. The name you enter will become the icon title unless you enter a 

description. Note that you can choose the directory where this file is saved, but the default directory is the 

application data directory specified during installation.

3. An icon associated with the profile will appear in the Session Manager.

Saving an FTP Client Configuration
You can save the FTP Client configuration in two ways:

• When exiting the FTP Client after you create or change a configuration in the FTP Client Session Configuration 

panel, you are prompted to select whether to save changes, exit, or continue to work in the application. If 

you select to save changes, type the file name and click Save. The default file type is .CFG and the default 

directory is the application data directory specified during installation.

• You can save configuration changes by selecting File->Save or File->Save As.
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Changing Configuration Information
You can change all of the configuration parameters in the workstation  profile.

Changing a Workstation  Profile
To change a workstation  profile, use the following procedure:

1. If your session window  is not active, select the icon corresponding to the workstation  profile to be changed.

The session window  appears.

2. Select Configure  from the Communication menu.

The subsequent steps are the same as for creating a new configuration, beginning with step 3  on page 29.

3. After you have made your changes, the following message appears:

      Because you have changed the configuration,
      communication will be terminated if you
      proceed. Are you sure?

If you click OK, communication ends, but then you are reconnected using the new configuration information.

To save the changes in your workstation  profile, click Save  from the File menu  in the session window  and then 

click Yes  to replace the existing file. Otherwise, click No  to save this information in a new configuration file.

Tip

Unless you have deselected Save on Exit  in the Exit Options dialog by selecting Exit  from the Settings  menu, changes 

are saved in the workstation  profile automatically whenever you exit a session.

Starting and Stopping Emulator Sessions
This chapter describes how to start and stop single and multiple emulator sessions.

If you saved your emulator configuration information, as described in Saving Configuration Information  on 

page 32, it is stored in a workstation  profile (*.WS), which should be displayed in the Session Manager.

Note:  If you are a first-time user of Z and I Emulator for Windows, or there are no session icons in the Session 

Manager, see Configuring Sessions  on page 29 to create a configuration.

Session Manager
Z and I Emulator for Windows  uses the Session Manager dialog to provide easy access to workstation profiles and 

batch files. You can use the Session Manager to start a single or multiple sessions, and create a new session or batch 

file.
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Note:  The Session Manager dialog only displays workstation profiles and batch files that are located in the 

Application Data location that was specified during Z and I Emulator for Windows  installation. See Application 

Data  on page 26 for more information about application data.

You can drag an icon from the Session Manager to the Windows®  Start menu or to the desktop. Select one or more 

sessions and drag with the right mouse button. A contextual menu appears when the icons are dropped, which gives 

you the options for moving, copying, or creating a shortcut. If you drag an icon with the left mouse button held down, 

the icon is moved to that location. If you drag an icon while pressing the Ctrl key and with the left mouse button held 

down, the icon is copied to that location. If you drag an icon while pressing the Alt key and with the left mouse button 

held down, a shortcut is created for the icon.

You should use the shortcut option whenever possible. Moving and copying will affect the location (and therefore 

the function) of the profile. Specifically, when you copy a profile to the desktop instead of creating a shortcut, you 

have actually created another profile. Any changes you make to the desktop profile will not be reflected in the original 

profile (and vice versa). Also, the desktop profile is located in the desktop folder (not in the application data folder) 

and will not appear in the Session Manager—the original version of the profile remains in the Session Manager.

Session Manager Options
Various Session Manager options are available from the pull-down menus and the right-click menu. For example, you 

can customize the look of the displayed Session Manager information and import sessions or batch files into the Z 

and I Emulator for Windows  Application Data directory.

Session Manager Menu
The following options are available from the Session Manager menu.

File

Change Directory

The user run files that are stored in a directory other than the Z and I Emulator for 

Windows  Application Data directory.

Import

This option allows the user to copy sessions or batch files to the Z and I Emulator for 

Windows  Application Data directory. Afterwards, the imported files is displayed in the 

Session Manager dialog.

View

Sessions

This option shows all valid workstation profiles that have the standard .WS extension and 

are located in the Application Data directory.
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Multiple Sessions

This option shows all valid batch files that are have the standard .BCH extension and are 

located in the Application Data directory.

All File Extensions

This option shows all valid multiple sessions and workstation profiles that are located in 

the Application Data directory, regardless of extension.

Hidden

This option shows files that have been previously hidden using the right-click menu 

option. If this option is selected, hidden sessions are shown with black-and-white icons; 

otherwise, they will not be displayed.

Large Icons

This option shows large session icons in the Session Manager.

Small Icons

This option shows small session icons in the Session Manager.

Details

The following session detail information is displayed in the panel columns. The columns 

can be resized as needed.

• File Name

• File extension

• Type (session or batch file)

• Description (shows the information specified in the Description=  field in the .WS 

file)

• The following session information is not shown for batch files.

◦ Host Name

◦ Host Type (shows the host type specified in the Customize Communication 

dialog during session configuration)

◦ Interface (shows the interface specified in the Customize Communication 

dialog during session configuration)

◦ Attachment (shows the attachment specified in the Customize 

Communication dialog during session configuration)

◦ Session Type (printer or display)

• Modified (indicates the last modification date/time of the file)

Refresh

If the user manually copy a session or batch file into the Application Data directory, the 

user must refresh the Session Manager view in order to see the new files.
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Package

Upgrade

The users can Upgrade to the latest RefreshPack via Session Manager (Online/Offline).

Rollback

The users can do the Rollback of installed RefreshPack via Session Manager (Online/Offline).

Detect and Repair

Detect and Repair might be automatically initiated if the Z and I Emulator for Windows installation is 

corrupted. This function uses Windows Installer to repair damage to the installed product. The user may 

be prompted for the installation source or image. User must be authorized in the System Policy to use 

this option. See Detect and Repair for more information about this feature.

Right-Click Menu (Contextual)
The following options are available by right-clicking on one or more session.

Start

Starts the selected sessions

Delete

Deletes the selected sessions. You must have permission in the System Policy to delete any sessions 

from the Session Manager.

Hide/Unhide

You can hide or unhide sessions using this option. To view hidden sessions, you must select View → 

Hidden. Hidden sessions have black-and-white icons when displayed.

Modify

This option is only available when selecting one or more batch files—the batch files are brought up 

in edit mode. You must have permission in the System Policy to modify batch files from the Session 

Manager.

Session Manager Online
ZIEWin  uses the ZIE service manager (referred to, as 'ZIE Server' going forward) to provide auto-upgrade capability 

and centralized management of configuration files.

The Session Manager Online notifies users if any new version of Z and I Emulator for Windows  is available online for 

update on the configured Web Server.

After confirmation from the User, Z and I Emulator for Windows  will be auto-upgraded to newer versions. Z and I 

Emulator for Windows  uses the Session Manager Online dialog to provide easy access to connect to the ZIE Server 
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and work with workstation profiles and batch files online. Users can configure the ZIE Server and work with their User 

Profiles in the Online mode, but by default, are not allowed to create new user entries on the server, unless permitted 

to do so, by a system administrator. To enable users to be able to create user entries, a ZIEWeb (Z and I Emulator for 

Web) administrator must enable the “Allow users to create accounts" check box on the ZIE for Web Server, using the 

ZIEWeb (Z and I Emulator for Web) Administration Console. The new users that are created are added to the "ZIEWin" 

group on the ZIE Server.

The ZIE Server can either be configured by providing the required server details in the 'InstallShield Wizard' at the time 

of ZIEWin  installation itself, or can be added/updated in the 'ZIE Server Detail' section of the Advanced tab within the 

Preferences. Users can migrate the Workstation profiles and batch files from Application Data location, upon login to 

the ZIE Server. If the User chooses to migrate, the Workstation profiles, batch files and their dependent files available 

on "Application Data" location get migrated

List of the supported files for online option are below:

• .ws  (Workstation profile)

• .bch -  (Multiple Sessions or Batch)

• .pmp  (Popup-Keypad Configuration)

• .kmp  (Keyboard Configuration)

• .bar  ( Toolbar Setup)

• .mmp  (Mouse Setup)

• .xlt  (Translation Table)

• .cmp  (Color mapping configuration file)

Multiple instances of the Session Manager (offline) can be invoked at a time, but for Session Manager Online, only 

one instance can be invoked at a time. An instance of Session Manager Online and Session Manager (offline) can 

both be operated simultaneously.

First time configuration of the Online Session Manager :

When you select Start or Configure Sessions - Online  for the first time from the Windows Start menu, the 'Z and I 

Emulator for Windows: Online' panel is displayed with the following tabs :

• Create User :

The 'Create User' window containing the fields, 'User Name', 'Password'  and 'Confirm Password'  is displayed 

to a user who launches the 'Z and I Emulator for Windows: Online' for the first time, to create a new User entry 

on the Server. (The New User entry will be created only if the entered User name and Password matches the 

required criteria. For more information about the criteria for valid user credentials, see the 'Quick Beginnings' 

book by selecting it from the Help  menu.) You can also click on 'Existing User' on the Create User page to use 

an existing ID on the server, instead of creating a new User entry.

Note:  After the successful creation of a user on the server and after migrating the user's profiles to the 

server successfully, the 'Create User' tab will not appear again and the user will be directly taken to the 

'Login' page, upon launching the 'Z and I Emulator for Windows: Online' subsequently.

• Login :
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After creating a user, Login window appears with username and password fields for user to login. If user 

wants to create a new user, user can go back to 'Create User' window by clicking on create-user link. User 

can also change the password by checking the box of 'Change Password', while logging in. Once the login is 

successful, user is directed to profile migration window.

• Profile Migration :

After a successful Login using an existing User Profile stored on the ZIE server, or upon the first time creation 

of a new User profile and connecting to the ZIE server, the user is taken to the 'Profile Migration' tab which 

gives the option to migrate (or upload) existing local user profiles (offline profiles) from the particular user's 

client machine to the ZIE server. The profiles that are migrated will be listed on the ZIE server as a server copy 

and can be retrieved for use thereafter, even if the offline copy of the profile is deleted from the client machine.

Session Manager - Online LOGIN Screen :

The Login  Screen is the default page that opens whenever the Online Session Manager is launched, if a User is 

already created on the server and the Profile migration is also completed successfully. A user can login to the Online 

session manager using any of the User Profiles that were created on the ZIE server. The user can also change the 

password by clicking on the check box for 'Change Password'  on the Login page. If the user name or password 

entered on the Login page are incorrect, the user gets prompted to either 'Re-try with different credentials' to Login 

again, or, to 'Run offline', i.e, to close the Online Session Manager and launch the Offline Session Manager instead. 

After successful logon, profiles will be retrieved from the ZIE server, and can be viewed in the sessions list.

Interoperability between ZIEWin and ZIEWeb clients:

ZIEWin v2.1introduced interoperability between ZIEWin and ZIEWeb (Host On-Demand) clients. This allows ZIEWin 

sessions to be accessed through ZIEWeb and ZIEweb - Web Client products after the session definitions were 

migrated (uploaded) to the ZIE server.

From v2.1 onwards, ZIEWin client communicates with the ZIE server over HTTP/HTTPS connectivity using JSON 

data.

For Managed ZIEWin users configured with ZIE server of version lower than v2.0, a migration utility has been provided 

along with ZIEWeb v2.0 server component, to migrate the ZIEWin session definitions stored on the ZIE server to the 

new format. The migration is a pre-requisite for those who plan to migrate their ZIEWeb server to v2.0 and ZIEWin 

client to v2.0 or higher.

Password provided during the user creation will be encrypted using AES 128-bit algorithm and sent to the server 

through the HTTP/HTTPS protocol as a JSON object. UID is added to the WS and BCH profile files for the unique 

identification. Only connection parameters are considered for the interoperability between ZIEWin and ZIEWeb clients 

and vice-versa.

After the ZIEWin sessions are converted and stored in the ZIE server, any changes made to the common parameters 

from any of the clients will be saved on the ZIE server. These parameter changes will be available to ZIEWinusers 

after the next login.

For more information on ZIEWeb - ZIEWin interoperability and common parameters, refer to Interoperability between 

HCL Z and I Emulator for Windows and HCL Z and I Emulator for Web Clients  on page 13

Session Manager Online Options :



Chapter 3. Using Z and I Emulator for Windows

• Start

Select one or more sessions or batch files in the Online mode, and click this button to start.

• New Session

Click this button to bring up the Customize Communication  panel in the Online mode.

• New Multiple Sessions

Click this button to bring up the Create/Modify Batch File  pane in the Online mode. You must be authorized in 

the System Policy to use this option.

• Logout

Click on this button to Logout from the Online Session Manager. It will prompt for a confirmation. When User 

confirms the logout, all the active online sessions will be ended automatically without any more confirmation 

for exit or Save. Session Manager Online's login screen will be displayed.

File menu options

• Upload

This option allows user to select and upload sessions or batch files to the ZIE server. Upload of user profile 

file will also upload the dependent configuration files ( like a .kmp file when associated with a .ws file etc) 

available in the same directory.

• Download

This option allows users to Download the profile files or batch files from the ZIE Server to the selected 

directory. Download of user profile file will also download the dependent configuration files ( like a .kmp file 

when associated with a .ws file etc).

• Exit

Clicking on Exit, will prompt for the confirmation, if user confirms the exit, the active online sessions will ended 

and the application is closed.

View menu options

• Sessions

This option shows all valid workstation profiles that have the standard .WS extension and are available in the 

ZIE Server.

• Multiple Sessions

This option shows all valid batch files that have the standard .BCH extension and are available in the ZIE 

Server.

• Large Icons

This option shows large session icons in the Session Manager.

• Small Icons

This option shows small session icons in the Session Manager.

• Details
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The following session detail information is displayed in the panel columns. The columns can be resized as 

needed.

◦ File Name

◦ File Extension

◦ Type

Session or Batch file

◦ Description

Shows the information specified in the Description=  field in the .WS file

◦ Host Name  (not shown for batch files)

Shows the host name for a Telnet session. If the session is not Telnet, other relevant information is 

shown (for example, the .ACG file name for SNA).

◦ Host Type  (not shown for batch files)

Shows the host type specified in the Customize Communication dialog during session configuration

◦ Interface  (not shown for batch files)

Shows the interface specified in the Customize Communication dialog during session configuration

◦ Attachment  (not shown for batch files)

Shows the attachment specified in the Customize Communication dialog during session configuration

◦ Session Type  (not shown for batch files)

Printer or Display

• All File Extensions

This option shows all valid multiple sessions and workstation profiles that are available in the ZIE Server, 

regardless of extension.

• Hidden

This option shows files that have been previously hidden using the right-click menu option. If this option is 

selected, hidden sessions are shown with black-and-white icons; otherwise, they will not be displayed.

• Refresh

This option refreshes the Session Manager view.

Detect and Repair

Detect and Repair might be automatically initiated if the Z and I Emulator for Windows  installation has been 

corrupted. This function uses Windows Installer to repair damage to the installed product; you may be prompted for 

the installation source or image.

You must be authorized in the System Policy to use this option. See Detect and Repair  on page 87 for more 

information about this feature.

Right-click menu options (contextual)

• Start

Starts the selected sessions
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• Delete

Deletes the selected sessions. You must have permission in the System Policy to delete any sessions from 

the Session Manager.

• Hide/Unhide

You can hide or unhide sessions using this option. To view hidden sessions, you must select View > Hidden. 

Hidden sessions have black-and-white icons when displayed.

• Modify

This option is only available when selecting one or more batch files; the batch files are brought up in edit 

mode. You must have permission in the System Policy to modify batch files from the Session Manager.

Icon drag-and-drop options

You can drag an icon from the Session Manager to the Windows Start menu or to the desktop. Select the session(s) 

and drag with the right mouse button. A contextual menu appears when the icons are dropped, which gives you the 

options for moving, copying, or creating a shortcut.

If you drag an icon with the left mouse button held down, the icon is moved to that location. If you drag an icon while 

pressing the CTRL key and with the left mouse button held down, the icon is copied to that location. If you drag an 

icon while pressing the ALT key and with the left mouse button held down, a shortcut is created for the icon.

You should use the shortcut option whenever possible. Moving and copying will affect the location (and therefore 

the function) of the profile. Specifically, when you copy a profile to the desktop instead of creating a shortcut, you 

have actually created another profile. Any changes you make to the desktop profile will not be reflected in the original 

profile (and vice versa). Also, the desktop profile is located in the desktop folder (not in the application data folder) 

and will not appear in the Session Manager (the original version of the profile remains in the Session Manager).

Installer Enhancements
ZIEWin  Installer panel

As part of Managed HCL  Z and I Emulator for Windows  (MZIEWin) feature, a panel is available in HCL 

Z and I Emulator for Windows  Installer, where a user provide the ZIE Server configuration details in the 

installation panel.

Here are the configuration parameters,

1. Web Server Details :  The URL of the Web Server from where HCL  Z and I Emulator for Windows 

fix pack file is downloaded for installation. Installer or fix pack is installed on the system by 

"Start or Configure Sessions - Online" program.

2. Config Server :  URL of the Application Server/Embedded Server, on which interoperability 

module (.war file) is deployed. It can be deployed on the Embedded Server or on any configured 

Application Server.

Example: http://< IP >/<Configured context root of the application>
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3. Config Server Port :  Port number of Application Server where interoperability module (.war file) 

is deployed.

Example: 9080.

The ZIE server configuration is optional only, user can click Next  to skip the configuration, and can 

configure this through "Preferences" utility post installation. For more details regarding the Preferences, 

see  Preferences  on page 102.

Auto-Update of HCL  Z and I Emulator for Windows  (ZIEWin):

ZIEWin  supports automatic upgrade. ZIE administrators manage the upgradation of ZIEWin  clients by 

placing the upgrade configuration file in the Web Server, which has the information of recommended fix-

packs or refresh packs that are available on the Web Server. The Web Sever URL can be provided during 

installation or can be configured via the "Preferences" utility.

When a User invokes the "Start or Configure Sessions - Online", the application checks if the installed 

version of ZIEWin  is lower than the recommended version. If the ZIEWin  installed on the system is of 

a lower version, the User gets a notification of the latest available ZIEWin  version. The User can either 

choose to upgrade or decline the upgrade option.

Note:  The upgrade configuration file is unique for every refresh pack installer and is shipped 

along with the Fixpack package.

For details regarding the Managed ZIEWin  Configuration parameters and changes in Preferences, see 

ZIE Server Details  on page 106.

Starting Sessions
You can use the following methods to start sessions:

• Select a previously configured session icon from the Session Manager.

• Start from an existing session window.

• Specify a workstation  profile name in the Run window.

• Enter the PCOMSTRT command in the Run window or MS-DOS prompt.

• Select an icon that has been previously dragged from the Session Manager.

• Start multiple sessions with a batch file.

Note:  Connection status messages are displayed on a status bar at the bottom of your session window 

during connection to the host.

Starting from the Start or Configure Sessions Icon

Select Programs →  HCL  Z and I Emulator for Windows  →  Start or Configure Sessions  from the Start 

menu. Select the desired session from the Session Manager dialog and click the Start  button.
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Starting from an Existing Session Window

Use the following methods to start from an existing session window:

Starting Another Session Using the Same Profile

Select Run the Same  from the File  menu. Another session starts, using the same profile.

Starting Another Session Using a Different Profile

1. Select Run Other  from the File menu.

The Open Other Workstation  Profile window  appears.

2. Double-click the desired workstation  profile in the File Name  list.

3. Select OK.

Another session starts, using the profile specified in step 2  on page 43.

Starting a Different Type of Session from a Session Window

1. Select Open  from the File menu.

2. Specify the desired workstation  profile and then select OK.

The current session ends and then another session starts, using the selected 

profile.

Starting Using a Command

To start a session, use the following procedure:

1. Start a DOS command prompt.

2. Enter the command

  PCOMSTRT /P=x:\AppData\my.WS

where my.WS  is the workstation  profile stored in the Application Data directory specified during 

installation. This is the only required parameter.

Note:  If multiple /p  parameters are given, PCOMSTRT only uses the last one to start a 

profile (.WS file).

For a complete description of parameters, refer to Administrator's Guide and Reference.

Another method for invoking Z and I Emulator for Windows  using a command is with the command for 

the PCSWS.EXE module (see Command line options for PCSWS.EXE  on page 44).

Starting Multiple Sessions
If you installed the Multiple Sessions utility, you can use the batch program PCSWS.EXE, which runs batch files 

(*.BCH), to start two or more workstation  profiles at the same time. Z and I Emulator for Windows  batch files can also 
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start other programs when you include their startup commands. This is especially useful if you always want to start 

an application when you start a session. For example, you might want to start an application, such as ZipPrint, that 

uses a Z and I Emulator for Windows  API.

Note:  You must have permission in the System Policy in order to create a new batch file.

If you created an icon for your batch file, double-click the icon in the Session Manager or select the icon and click the 

Start  button.

Command line options for PCSWS.EXE
You can use the following options when creating or modifying a batch file.

• batch filev optionv optionTo specify which view should be used during a session, add the command /V=myview, where myview  is the 

name of the previously saved view:

 C:\ZIEWin\PCSWS.EXE C:\AppData\LAN1.WS /V=myview 

If the specified view does not exist, the command is ignored. See Managing Emulator Sessions  on page 86

for information on how to save a view.

• batch fileq optionq optionTo suppress the HCL  logo when you start one or more sessions, add the parameter /Q  to the first command in 

the batch file:

 C:\ZIEWin\PCSWS.EXE C:\AppData\TCPIP1.WS /Q

where C:\ZIEWin\  is the directory where you have Z and I Emulator for Windows  installed, and C:\AppData\  is 

the Application Data directory.

• i optionbatch filei optionTo start a session as an icon, not as a window, add the parameter /I  to the command in the batch file:

  C:\ZIEWin\PCSWS.EXE C:\AppData\LAN1.WS /I

where C:\ZIEWin\  is the directory where you have Z and I Emulator for Windows  installed, and C:\AppData\  is 

the Application Data directory.

• batch fileh optionTo start a hidden  session, not as an icon or a window, add the parameter /H  to the command in the batch file:

  C:\ZIEWin\PCSWS.EXE C:\AppData\LAN1.WS /H

where C:\ZIEWin\  is the directory where you have Z and I Emulator for Windows  installed, and C:\AppData\  is 

the Application Data directory.

• s optionbatch files optionTo start a session with a specific short session ID (session letter), insert the parameter /S=m  after PCSWS.EXE 

in the batch file:

  C:\ZIEWin\PCSWS.EXE /S=m C:\AppData\LAN1.WS

where C:\ZIEWin\  is the directory where you have Z and I Emulator for Windows  installed, m  is the short 

session ID, and C:\AppData\  is the Application Data directory.

• To start a macro after the session start, add the parameter /M  to the command in the batch file:

 C:\ZIEWin\PCSWS.EXE C:\AppData\LAN1.WS /M=mymacro 
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where C:\ZIEWin\  is the directory where you have Z and I Emulator for Windows  installed, C:\AppData\  is the 

Application Data directory,

LAN1.WS

is the profile, and

mymacro

is the Z and I Emulator for Windows  macro/script file name.

If the specified macro/script does not exist, there will be a pop up with "PCSKBD400- The file: <macro name> 

is not a Z and I Emulator for Windows  macro/script-file."

Note:

1. sessionsstarting specific session IDsessionsIDs forIf you use the /S option to assign A as the short session ID, you should use this option for all of the 

sessions in the batch file. Otherwise, if another session starts first, it becomes the A Session and the 

session with the /S=a  option will not start because of the conflicting short session IDs. Another way to 

prevent conflicts is to assign a character later in the alphabet for the short session ID.

2. Several parameters can be specified for controlling the particular characteristics for starting sessions; 

the switch values are designated by a single character.

Creating a Batch File
To create a batch file, use the following procedure:

1. From the Session Manager dialog, click New Multiple Sessions. You can also start a new batch file from the 

Windows®  Start  menu, using the HCL  Z and I Emulator for Windows  →  Utilities →  Multiple Sessions  program.

The Create/Modify Batch File panel appears.

2. There are several methods for including profiles or programs in a batch file:

• Double-click the file names in the File Name  list box.

• Drag and drop the file names (using the right mouse button) from the File Name  box to Batch-File 

Entries.

• Select a file name from the File Name  list box and then select Add.

• Type the complete path and command file name in the batch files entries area.

• You can also use the Capture View  button to capture multiple session windows into a view.

Z and I Emulator for Windows  places the full path and command that is needed to run the workstation  profile 

or other program above the cursor line in the edit area. If there is no cursor, the command is added to the last 

line.

To see the contents of the profile you added to the batch file, click it in the File Name  list box and then click 

View File  or the magnifying glass.
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Note:  Some brief instructions appear at the top of Batch-File Entries; you need not remove them, 

because they do not affect the running of the batch file.

3. Repeat step 2  on page 45 for each subsequent file to be added.

4. When you complete the edit, save the created batch file by selecting Save  from the File  menu.

The Save Batch File As window  appears.

5. Enter a name for the batch file (*.BCH).

The name you enter is used as the icon title, unless you enter a description as well.

The following example is a batch file that runs four workstation  profiles located in the Application Data directory, and 

then runs MYAPP.EXE.

C:\dir\PCSWS.EXE C:\AppData\SLAN1.WS
C:\dir\PCSWS.EXE C:\AppData\SLAN2.WS
C:\dir\PCSWS.EXE C:\AppData\AS4Y1.WS
C:\dir\PCSWS.EXE C:\AppData\VT220.WS
C:\APPL\MYAPP.EXE

where C:\AppData  is the Application Data directory specified during installation and dir  is the installation directory.

Saving Multiple Session Views
You can use the Create/Modify Batch File panel to capture up to multiple session views. Simply size and position up 

to Maximum session windows, which is configured in the Preferences and click the Capture View  button.  Name the 

view and click Save View  in the View Setup panel. You can save up to eight views. You may also delete previously 

saved views from the drop-down list in the View Setup panel.

If a view is already being used when you click Capture View, that view is automatically used and you are not prompted 

to save a new view.

Starting a Batch File
You can use one of the following methods to run a batch file:

• If you created an icon for your batch file, double-click the icon in the Session Manager or select the icon and 

click the Start  button.

• Run the batch file from the Run command line:

  [drive]:\[path]\PCSBAT.EXE  [drive]:\[path]\xxxx.BCH /R

Note:  To run a batch file, specify the /R option.

• Start the Multiple Sessions  Utility.

1. Select Open  from the File  menu  in the Create/Modify Batch File window.

2. Select the desired batch file and then select OK.

The contents of the batch file appears in the edit area.

3. Select Run  from the Run menu.
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Editing an Existing Batch File
To edit an existing batch file, do one of the following:

• Right-click on the icon in the Session Manager and choose Modify.

You can also use the following procedure:

1. Start the Multiple Sessions  Utility from the Start menu. The Create/Modify Batch File window appears.

2. Select Open  from the File menu. The Open Batch File window  appears.

3. Select the batch file you want to edit and then select OK. The contents of the batch file you selected 

appear in the edit area of the Create/Modify Batch File window.

• Edit the batch file. See step 2  on page 45 for more details.

• When you complete the edit, save your changes by selecting Save  or Save As  from the File  menu.

◦ Select Save  to save your changes in the existing file.

◦ Select Save As  to save your changes in a new file and then continue with step 5  on page 46.

• Exit the Create/Modify window.

Starting Multiple Sessions without a Batch File
To start multiple sessions without a batch file, use the following procedure:

1. Start the Session Manager.

2. Select the icons for the sessions, then click the Start  button. You can select icons using a drag selection box 

or holding down the Ctrl key while selecting icons with the mouse.

3. After it connects to the host, select one of the following choices from the File  menu:

• Run the Same  to start another session with the same configuration.

• Run Other  to start a session with a different configuration.

When the Open Other Workstation  window appears, select the profile you want to start and then click 

OK.

Automatically Starting Sessions
To start one or more sessions automatically, use the following procedure:

1. From the Start  menu, select Settings →  Taskbar.

2. Click the Start Menu Programs  tab and then click Add.

3. Click Browse  and then open the Application Data directory specified during installation.

4. Change the file type to All Files.

5. Double-click the session icon or the batch icon.

6. Click Next  and then double-click the Startup folder.
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7. Accept the icon name or type a new one.

8. Click Finish  and then OK  when you are done.

You can also drag an icon from the Session Manager to the Startup folder as a shortcut.

Stopping Sessions
To stop a session, click the X  in the upper right corner or double-click the upper left corner of the session window, or 

select Exit  from the File  menu.

To stop multiple sessions at the same time, select Exit All  from the File menu. All emulator sessions end, and the 

associated session windows are closed.

Sessions can also be stopped using a command:

1. Select Run  or Programs →  MS-DOS®  Prompt  from the Start menu.

2. Enter one of the following commands:

   PCOMSTOP /S=x   
   PCOMSTOP /ALL

where x  is the session letter of the particular session to be stopped; use ALL  to stop all active sessions. There 

are other parameters; for a complete description, refer to Emulator User's Reference.

Note:  Stopping a Telnet session automatically closes an associated printer session, if that option was 

selected when configuring the session. See Printer Session Association  on page 51 for information on 

how to automatically close an associated printer session.

Option to suppress confirmation message for pcomstop
When invoking pcomstop.exe from the command line, the NCE option can be used to suppress the exit confirmation 

message, which is shown when one or all sessions.

Example:

PCOMSTOP /S=<session>|/ALL [/Q] [/C] [/NCE] [/?]

One of the following parameters must be specified:

• /S stops the session, while <session> is the letter of the session to be stopped

• /ALL stops all sessions

The following parameters are optional:

• /Q specifies quiet mode

• /C converts the output to Windows code page
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• /NCE (No Confirm on Exit) stops one or all sessions (as defined by /S or /ALL) without confirmation, even if 

the Confirm on Exit or Exit All options are set.

• /? displays help information

Stopping an emulator session without access to the tool bar
This method can help you to stop a session when security restrictions do not allow tool bar access.

To stop an emulator session without access to the tool bar, you can use the mouse or a keyboard shortcut to launch 

pcomstop.exe. Use the following procedure to set up the pcomstop.exe shortcut:

1. Create a shortcut for pcomstop.exe on the desktop or wherever you need.

2. Right-click the shortcut to view the Properties  window.

3. Click the Shortcut  tab.

4. The executable name and path are in the Target  input box. Append any required parameters to this path and 

click OK. These parameters will be used when the pcomstop.exe file is launched. For example, if you want to 

stop session A, modify the appended path:

"E:\Program Files\HCL\Z and I Emulator for Windows\pcomstop.exe" /s=a

Note:  The /S or /ALL option is required to run pcomstop.exe. The /ALL option stops all sessions, while 

the /S=x option stops a particular session (where x is the session letter).

5. In the Shortcut Key  input box, type the key that you want to use as a shortcut (for example, X), and click OK.

You can then launch pcomstop.exe by the following methods:

• Mouse

• Double-click the modified shortcut

• Keyboard

Windows®  always adds the Ctrl+Alt sequence to the shortcut key. For example, Ctrl+Alt+X becomes the shortcut for 

invoking pcomstop.exe and closes the emulator session.

Using Emulator Sessions
This chapter describes how to use the printing, editing, and data transfer functions in an emulator session. It also 

describes some of the choices in the emulator session Actions, Window, and Settings →  Appearance  menus.

Accessibility
Z and I Emulator for Windows  provides functionality with assistive technology such as screen readers. Following are 

some of the accessibility-related enhancements.
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Sounds
Z and I Emulator for Windows  supports the ShowSounds  and SoundsSentry  options available in the Windows® 

Control Panel →  Accessibility Options →  Sound  dialog. The ShowSounds  option displays a string representing the 

event that generated a sound in the status bar.

To mute all of the sounds generated by Z and I Emulator for Windows, select the Mute  option in the Settings → 

Appearance →  Display Setup →  Sound  panel.

Screen Reader Assist
Users can configure a toggle key to enable Z and I Emulator for Windows  to replace blank and null characters in 

the input field with another character. This option enables screen readers to report the length of the field to visually 

impaired users. Data sent to and from the host is not changed—only the screen display and the screen reader's 

voicing of the display are affected. By default, this function is not enabled.

For 3270 and VT emulators, the default padding character is a blank. For 5250, the default replacement character is 

an underscore. You can choose another character if you prefer.

During the emulation session, you can turn the screen reader assist on or off, as needed. To map the screen reader 

toggle to a key, click Settings →  Keyboard. Click Customize  to access the keyboard setup dialog. Refer to the online 

help for a complete list of available keyboard functions.

Expanded OIA
For an accessible version of the Operator Information Area (bottom line of the session), you can display the expanded 

OIA window. Click View →  Expanded OIA  from the session menu bar. You can also select Show Expanded OIA  from 

the session's system menu. You can change the number of lines displayed in the expanded OIA in the Settings → 

Appearance →  Window Setup  dialog.

To set focus to the expanded OIA so that a screen reader can read the values, you need to map a key to the function 

OIA: Toggle focus to/from Expanded OIA. This key enables you to toggle focus back and forth between the session 

window and the expanded OIA window. When you set focus to the expanded OIA window with a key, the focus in the 

expanded OIA is always set to the first line. When you return to the session window, the cursor should be where it 

was before you went into the expanded OIA window. Refer to the online help in the Settings →  Keyboard →  Customize 

dialog, for more information about custom key mapping.

Popup Keypad
Even though most users use the popup keypad with a mouse, it is possible to customize and use the poppads with 

the keyboard alone. To display (execute) a poppad without a mouse, you must map a few keys in the Settings → 

Keyboard →  Customize  dialog.

The Display Poppad  function shows the last poppad and puts keyboard focus on it. The functions Display Poppad 

Pad 1, Display Poppad Pad 2, Display Poppad Pad 3, and Display Poppad Pad 4  display a specific poppad and put 

keyboard focus on that pad. You can execute the button with current focus by pressing the space bar or the Enter key.
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If you are using a sticky poppad, the poppad window remains open until you close it. A regular poppad exits when 

you push one of the buttons. To get focus to a sticky pad without a mouse, you must map the Set Focus to Poppad 

function to a key—this sets focus to the sticky poppad from the session window. Because you must use the Ctrl-Tab 

key combination to get focus from the sticky poppad back to the session, mapping the Set Focus to Poppad  function 

to the Ctrl-Tab key combination is not advisable.

Quick Connect
You can connect a Telnet (3270/5250/ASCII) session quickly using the Quick Connect bar by configuring only Host, 

Port and LU Name (3270)/Workstation Id (5250). The LU Name and Workstation ID are optional.

The Quick Connect bar is enabled only for Telnet sessions (both display and Printer). For non-Telnet Sessions, the 

Quick Connect bar does not appear.

While using the Quick Connect bar, the other session parameters are taken from the active session, if any. If no 

session is active, then all session parameters will be of default.

You can activate or deactivate the Quick Connect bar by clicking View -> Quick Connect Bar  in the session window 

menu.

Power Management
Z and I Emulator for Windows  complies with Microsoft Windows Power Management requirements for handling sleep 

events (stand by and hibernate). This support minimizes session interruptions due to network disconnections caused 

by sleep on Windows 7  and later versions.

Refer to the Administrator's Guide and Reference  for more information about Power Management.

Connected State
When Z and I Emulator for Windows  is in the connected state and Windows 7  or later operating system indicates that 

the user is available for interaction, Z and I Emulator for Windows  prompts the user to grant permission to sleep.

You can specify a setting in the Preferences Manager  that allows the system to standby or hibernate without 

prompting. In default mode (unchecked), if there is at least one connected session, you will be prompted to allow the 

system to standby or hibernate. If there are no connected sessions, Z and I Emulator for Windows  allows the system 

to standby or hibernate without prompting. See Standby/Hibernate  on page 108.

Non-Connected State
When Z and I Emulator for Windows  is not in the connected state, Windows 7  and later operating systems might 

automatically sleep, without prompting the user for permission.

Critical Sleep
When Windows 7  and later operating system's resumes after an emergency suspension, Z and I Emulator for 

Windows  might display and log a warning message.
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Printer Session Association
When you configure a 3270 or 5250 display session, Z and I Emulator for Windows  lets you specify an associated 

printer session.

Advantages of this association are as follows:

• If sessions are associated, the person who configures the client workstation does not have to know any 

details about the printer session.

• When you start the display session, the associated printer session is started automatically.

When configuring a session, if you want the server to associate a printer with the session, do the following:

1. Click the Printer Association  tab.

2. Select Associated Printer Session.

3. Enter the .WS file for the printer that is to be associated with the session. You can also click Browse  to locate 

the file.

You can also set the following options:

• Select the Start Associated Printer Minimized  check box, if preferred. This option is unavailable until an 

associated printer is selected.

• Select the Automatically close Associated Printer Session with this session  check box, if preferred. This 

option is unavailable until an associated printer is selected.

• Select Associated device name  to associate the display session with any printer device that currently exists 

on an iSeries™, eServer™  i5, or System i5™  host. This option is only available for 5250 sessions.

Note:

1. Stopping a Telnet session automatically closes an associated printer session, if that option was 

selected when configuring the session.

2. If a 5250 printer session is associated with multiple 5250 display sessions, then the printer session 

ends only when the last associated display session ends.

3. For a 5250 session, if the host name in the selected printer session profile differs from the values in 

the display session profile, then the display session profile host name is used instead. The display 

session values are not saved to the printer session profile.

Print Session Setup (3270 and 5250)
The Print Session Setup dialog enables you to customize the display options for a 3270 or 5250 printer session. This 

dialog can be accessed by clicking Settings →  Appearance →  Print Session Setup. You can also add the Print Session 

Setup dialog to the session tool bar.
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The following customization options are available.

Show Text Information

You can specify the title and other information to be shown in the printer session display window. If this 

option is not selected, no text information about the session is displayed.

Configuration Details

The following items can be included in the text information.

Connection Details

The following display options are based on the session status and the settings of the 

Session Parameters →  Advanced  and Customize Communications  dialog.

Connection Sta

tus

If this item is selected, Connected  is displayed if the session is in 

connected state. Disconnected  is displayed if the session is not 

connected.

Host Name Host name or the IP address for the connection.

Host Type Host system type to which the session is connected.

Interface Interface type selected in the Customize Communication  dialog.

Attachment Physical and logical connection selected for the session.

WS Profile If the session is started from a saved workstation (.WS) profile, the 

name of the profile is displayed. The field is blank if it is a newly 

configured session.

Host Codepage Code page selected in the host Session Parameters configuration 

panel.

Host Device Details

The following display options are based on the selected device and the settings of the 

Session Parameters – 5250 Host > Advanced  dialog. These options are available for 5250 

sessions only.

Device Status If this item is selected, Started  is displayed if the device is in ready 

state. Stopped  is displayed if the device is not in Ready state.

Workstation ID Device name for the session.

Message 

Queue/Library

Message Queue  and Message Library  specified in the Session Para

meters →  Advanced  dialog

Host Font Host font selected in the Session Parameters →  Advanced  dialog

HPT If this item is selected, TRUE  is displayed if Host Print Transform  is 

enabled. FALSE  is displayed if HPT is not enabled.

HPT Printer 

Model

If this item is selected, the Printer Model  is displayed. If HPT is not 

enabled, Not configured  is displayed.

HPT Drawer 1 If this item is selected, the HPT Drawer 1  paper size is displayed. If 

HPT is not enabled, Not configured  is displayed.
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HPT Drawer 2 If this item is selected, the HPT Drawer 2  paper size is displayed. If 

HPT is not enabled, Not configured  is displayed.

Envelope Hop

per

If this item is selected, the Envelope Hopper  is displayed. If HPT is 

not enabled, Not configured  is displayed.

Customization 

Object/Library

If this item is selected, the Customizing Object  and Customizing 

Library  are displayed. If HPT is not enabled, Not configured  is dis

played.

ASCII code 

page 899

If this item is selected, TRUE  or FALSE  is displayed, depending on 

whether ASCII Code Page 899  is enabled. If HPT is not enabled, Not 

configured  is displayed.

• Page Setup Details

The following display options are based on the workstation profile and the Page Setup  dialog. 

For 3270 sessions, the listed options are on the Text  and Text Options  tabs. For 5250 sessions, 

the listed options are on the Orientation  and Advanced Options  tabs.

CPI/LPI

(3270 sessions on

ly)

Number of characters printed per inch and number of lines per inch.

MPL/MPP

(3270 sessions on

ly)

Maximum print line and maximum print position.

Font Name

(3270 sessions on

ly)

Device font of the printer device driver.

Margin – Left/Top Left and top margin values.

Drawer1 Drawer 1 orientation.

Drawer2 Drawer 2 orientation.

Bestfit Scaling If this item is selected, TRUE  is displayed if Bestfit is enabled in the .WS 

profile. If Bestfit is not enabled, FALSE  is displayed.

Suppress Null 

Lines

(3270 sessions on

ly)

If this item is selected, TRUE  is displayed if Suppress Null Lines  is en

abled. If Suppress Null Lines  is not enabled, FALSE  is displayed.

Nulls as Spaces

(3270 sessions on

ly)

If this item is selected, TRUE  is displayed if Nulls as Spaces  is enabled. 

If Nulls as Spaces  is not enabled, FALSE  is displayed.

Ignore FF at First 

PP

If this item is selected, TRUE  is displayed if Ignore FF at First PP  is en

abled. If Ignore FF at First PP  is not enabled, FALSE  is displayed.
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(3270 sessions on

ly)

FF Takes PP if fol

lowed by Data

(3270 sessions on

ly)

If this item is selected, TRUE  is displayed if FF Takes PP if followed 

by Data  is enabled. If FF Takes PP if followed by Data  is not enabled, 

FALSE  is displayed.

CR at Max PP + 1

(3270 sessions on

ly)

If this item is selected, TRUE  is displayed if CR at Max PP + 1  is en

abled. If CR at Max PP + 1  is not enabled, FALSE  is displayed.

NL at Max PP + 1

(3270 sessions on

ly)

If this item is selected, TRUE  is displayed if NL at Max PP + 1  is en

abled. If NL at Max PP + 1  is not enabled, FALSE  is displayed.

FF - Any Position / 

Column 1

(3270 sessions on

ly)

If this item is selected, TRUE  is displayed if FF - Any Position / Column 

1  is enabled. If FF - Any Position / Column 1  is not enabled, FALSE  is 

displayed.

Ignore color while 

printing

(3270 & VT ses

sions only)

Select this option to ignore the colors in PS and print in black & white.

Replace FF by LF

(3270 and 5250 

sessions only)

Select this option to replace a form feed by the number of lines entered 

in the edit box.

Automatic Orienta

tion

If this item is selected, TRUE  is displayed if automatic page orientation 

is enabled. If automatic page orientation is not enabled, FALSE  is dis

played.

Printer Font Code

page

The printer font code page used for printing on the workstation.

No CR between 

Fields

If this item is selected, TRUE  is displayed if No CR between Fields  is en

abled. If No CR between Fields  is not enabled, FALSE  is displayed.

Bold as Normal If this item is selected, TRUE  is displayed if Bold as Normal  is enabled. 

If Bold as Normal  is not enabled, FALSE  is displayed.

Use Raster Fonts If this item is selected, TRUE  is displayed if Use Raster Fonts  is en

abled. If Use Raster Fonts  is not enabled, FALSE  is displayed.

Show Wallpaper

You can specify a bitmap file as a background in the session window. You can use the default graphic or 

another monochrome, 16-color, 256-color, or 24-bit file.
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Print Status Dialog →  Show Dialog

You can have a printer status dialog displayed along with the session window. This option is available 

only for 5250 sessions.

Print Status Dialog →  Contain in Session Window

You can display a printer status dialog that is tied to the session window. When the session window is 

moved or minimized, the printer status dialog is moved with it. This option is available only for 5250 

sessions.

Printing
You can use Z and I Emulator for Windows  to print from display or printer sessions:

• From display sessions, you can print all (Print Screen) or part (Trim Print) of the screen of your session 

window  on a workstation  printer.

To print only part of the session window, drag the mouse to create a trimming rectangle around the part of the 

window  you want to print and then select Print Screen  from the File  menu.

• With printer sessions, you can print files directly from a host system to a workstation  printer. Refer to the 

online help for more information.

Configure a printer session to designate a workstation  printer as a system printer that will use either the 

printer definition tables (PDTs) provided with Z and I Emulator for Windows  or the Windows®  printer drivers. 

Refer to the online help for more information.

To print, the following methods apply:

• You can use Windows®  printer drivers that you configure through the session  File →  Printer Setup  menu.

• You can use printer definition tables (PDTs), which give greater control over the print data stream.

• For 5250 only: You can use Host Print Transform, where the host formats and builds the printer commands.

For more information about printing, refer to Emulator User's Reference.

Print Screen Collection functions
Using the Collect Screen  function, you can add a capture of all or part of the screen to a collection of captures.

To add the current screen (or part of the screen) to the collection, click File →  Print Screen Collection →  Collect 

Screen.

To print and purge all the collected screens, click File →  Print Screen Collection →  Print and Purge Collection.

To print and keep all the collected screens, click File →  Print Screen Collection →  Print and Keep Collection.

To preview the collected screen and select collected screens to be printed or purge, click File →  Print Screen 

Collection →  Prpcess Collection.
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All the collected screens can be deleted without printing by clicking File →  Print Screen Collection →  Purge Collection. 

An individual screen or part of the collection cannot be deleted.

The File →  Print Screen Collection →  Print Collection on Exit  option ensures that the collected screens are printed 

before you close or disconnect the session. This option is enabled by default. To end the session without printing the 

collected screen, clear the Print Collection on Exit option. All the collected screens are then deleted when you close or 

disconnect the session.

Note:  The Collect Screen feature works independently of the normal Print Screen  function. You can still use 

Print Screen to print individual screens, while collecting multiple screens.

You can add the Collect Screen  and Print Collection  functions to the toolbar, a popup keypad, or a custom keyboard 

map. The settings in the Page Setup dialog are used (shared with the normal Print Screen function).

In PDT mode, there is an option available for printing more than one screen in a page. Refer to Administrator's Guide 

and Reference  for more information.

Collecting Print Jobs (5250 Printer Session)
You can collect 5250 print jobs and print them as a single job or in a group. The collected print jobs are stored in 

a .SCS file.

You can set the following .WS profile keywords to specify the path and file name for the .SCS file.

[Printers]
SCSFile=<filename>.scs
SCSPath=<local path>

The functions associated with this feature are listed below. The functions can be mapped to the keyboard, popup 

keypad, mouse button, or toolbar button.

• Collect Mode

When Collect Mode has been started, print jobs that have been sent are saved in the .SCS file. They are not 

printed immediately.

• Print Collection

The print jobs that have been saved are sent to the printer as a single job.

• Purge Collection

The collected print jobs are deleted.

Refer to the online help for details about mapping the functions.

The CombineJobs profile keyword enables you to collect the jobs for printing, while maintaining them as individual 

jobs (instead of one job in the .SCS file). Specify the .WS keyword as follows:

[Printers]
CombineJobs=N

If you set CombineJobs to N, the Print Collection function sends the separate, collected jobs to the printer. While in 

Collect Mode, if the keyword is set to Y  or is not specified, the print jobs are combined as a single job in the .SCS file.
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Using the Windows Printer Driver
To set up your printer to use a Windows®  printer driver:

1. Click File →  Printer Setup  in the session window.

The Printer Setup window lists the supported printers.

2. Select the printer driver to be used from the Printer  list box. DEFAULT  will cause the use of the Windows® 

default printer.

Note:

a. The DEFAULT  selection is shown when the .WS file specifies printer=DEFAULT  in the [printers] 

stanza.

b. When this selection is made, no message appears before the job is printed.

c. When a printer has been selected for a session, the name of that printer is displayed in the 

status bar of the session window.

3. If desired, click on the check box to Show this dialog before every print.

4. Confirm that the Use PDT file  check box is not selected and then select OK.

Z and I Emulator for Windows  will now use the printer driver you selected, and the Printer Setup window is 

closed.

Using Printer Definition Table (PDT) Files
Printer Definition Table files define the transfer of characters and control codes to a printer, and the printer output 

format. If a PDT file is used, the Windows®  printer driver is not used, and Z and I Emulator for Windows  generates 

print output based on printer control information defined in the PDT file.

Refer to Administrator's Guide and Reference  for more information about PDT files.

To use PDT files:

1. Click File →  Printer Setup  in the session window.

The Printer Setup window appears.

2. Select the port to be used from the Printer  list box.

Selected PDT files are available for the port selected here.

3. Select Setup  and then specify the paper size of the selected printer driver.

4. Select the Use PDT file  check box  and then select Select PDT.

The Select PDT file window appears.

5. To use an existing PDT file, select a PDT file to be used and then select OK.
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Using Host Print Transform (5250 only)
When configuring a 5250 printer session, the HPT mode may be selected. To use Host Print Transform (HPT), do the 

following:

1. From the Session Parameters panel, click Advanced.

2. Select HPT Yes. You can then enter the following parameters:

• Printer Module

• Drawer 1, Drawer 2, and Envelope form names

• Code Page 899, Yes  or No

• Customizing Object and Library (optional)

Image Print Transform
Z and I Emulator for Windows  allows use of Image Print Transform in 5250 print sessions, when using Host 

Print Transform. Refer to the most recent IBM®  iSeries™, eServer™  i5, or System i5™  printing reference for more 

information on this feature.

Page Setup
Z and I Emulator for Windows  allows you to set Page Setup parameters, such as the maximum number of lines per 

page, the maximum number of columns, and fonts. You can also add a header or footer to a page.

For detailed Page Setup information and instructions, refer to Emulator User's Reference.

Scalable (Truetype) APL Font Support on Printers
Because special APL characters are not provided for printers, the APL fonts provided for displays are used when APL 

characters are printed. In some cases, APL characters are printed rather small. To print larger APL characters, you 

should install the Z and I Emulator for Windows  AICAPL font, using the Windows Control Panel →  Font  dialog.

ZipPrint (3270 Only)
ZipPrintCMS filePROFS note, calendar, document printing3270 session screenXEDIT workspaceprinting3270 session screenZipPrintCMS file

Use ZipPrint to print PROFS®  notes, calendars, CMS files, XEDIT workspaces, and 3270 session screens.

Preparing to Use ZipPrint
Before you can use ZipPrint, DDE/EHLLAPI must be enabled for the sessions. To do this, click Settings →  API  and 

refer to the online help for detailed instructions. DDE/EHLLAPI is enabled by default.
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Note:  By default, PROFS-oriented functions of ZipPrint are U.S. English PROFS®. You can customize ZipPrint 

for other languages. Start ZipPrint before you start any display sessions.

Starting ZipPrint
Start ZipPrint before you start any display sessions. The ZipPrint menu  is added to the menu bar  of the specified 

session window; then you can use it from the menu bar  the same as with the other functions.

Start ZipPrint by selecting the ZipPrint  icon in the Z and I Emulator for Windows  program folder. This starts ZipPrint 

for Session A only.

You can also start ZipPrint by placing it as the first command in a Z and I Emulator for Windows  batch file.

For more information about ZipPrint, including information about using ZipPrint for additional emulator sessions, 

search for ZipPrint in Help.

Using ZipPrint
Keep the following consideration in mind when using ZipPrint.

ZipPrint uses the Z and I Emulator for Windows  File Transfer function to print VM/CMS notes and files. On slower 

communication lines such as SDLC, Async (IIN), or when using a large packet or block size, you might experience a 

file transfer timeout. If this happens, you should increase the timeout delay  as follows:

1. Click Settings →  Transfer  in the session window.

2. Increase the timeout value to 150 seconds or longer.

Editing
You can edit the contents of your session window  using the Windows®  clipboard  and the Edit  menu.

Note:  When using copy/cut functions, Z and I Emulator for Windows  takes the entire contents from the 

session window and places it on the clipboard. To copy or cut only marked sections from the session window, 

you need to update the Cut/Copy options. To update the Cut/Copy options, do the following:

1. Click Settings →  Edit.

2. From the Edit Options window, select the Cut/Copy  tab.

3. From the Cut/Copy page, select the Only if a trim-rectangle is marked  check box.

4. Close the Edit Options window.

Undo

Cancels the most recent Edit operation, except for Copy Link, and restores the contents of the session 

window  and the clipboard  accordingly.
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Cut

Copies the marked area into the clipboard  and removes it from the display session window.

Copy

Copies (or duplicates) the marked area into the clipboard  without removing it from the display session 

window.

Copy Append

Copies the marked area into the clipboard  without removing it from the display session window. If there 

is already data in the clipboard, Copy Append adds the new data to it.

Copy As Image

Copies the marked area as a bitmap into the clipboard. If no area is marked, Copy As Image captures 

the entire presentation space as bitmap.

Note:  Undo functionality is not supported for Copy As Image.

Paste

Overlays the current contents of the clipboard  into the session window, starting at the current cursor 

position.

Paste Next

If not all data was pasted, Paste Next is enabled and the remaining clipboard data can be pasted.

Clear

Removes the marked area of the session window. The clipboard  contents are not altered.

Copy Link

Supports the DDE Copy Link function. To start a link between Z and I Emulator for Windows  and another 

application program, mark an area of the session window, select Copy Link, and then select Paste Link 

in the other application program.

Note:  The command you should use for Paste Link or Paste Special depends on the application 

program you are using.

Find

Find text in Presentation Space of a display session. The text found is highlighted on screen. The search 

can be case sensitive or insensitive.

Send to Scratch Pad

Sends the selected contents of the Presentation Space into the Scratch Pad of the corresponding 

session.
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Unmark

Removes the clipping (or marking) rectangle. The session window  and the clipboard  contents are not 

altered.

Select All

Marks the entire session window.

Edit Options

Paste Options
You can control how text is pasted before and after protected fields, and how tabulated text appears after it is pasted. 

The following Paste functions are available.

Field Wrap

Check this box if you want pasted data that falls onto a protected field to move to the next unprotected 

field. If you do not check this box, any data that falls onto an unprotected field is lost.

Line Wrap

Check this box to allow pasting of copied text across lines.

Don't Split Words

Check this box to avoid words being split across fields and lines. The text being pasted into fields is 

split on word boundaries, which breaks the text and starts the new word in the next field. If one word is 

being pasted into a field, but the field is not long enough to hold the word, then as much of the word as 

possible is put into the field, and the rest of the word is carried on to the next field.

Note:  If the Field Wrap or Line Wrap option is not enabled, the word break option is not available.

Paste to marked area

Check this box to restrict pasting to a marked area, if it exists. If the marked area doesn't exist, pasting 

will take place at the current location.

Stop pasting when protected line encountered

Check this box to have the pasted text stop when it comes to a protected line on the emulator screen. If 

you do not check this box, the paste continues.

Tab Character Processing

Advance to next tab stop

You can choose to align tabulated text at specified tab stops. For example, if you choose 

Advance to next tab stop 4 column(s), your tabulated text is advanced to the column 

position that is the next multiple of 4.
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Replace with n space(s)

You can choose to replace tab stops with a certain number of spaces. For example, if you 

choose replace with 3 spaces, each tab stop in your original text becomes 3 spaces.

The default setting is to replace each tab character with one space.

Paste data to fields

You can choose to have tabulated text placed in subsequent unprotected fields. With this 

option, when a tab character is encountered, the following text data will be pasted into the 

next unprotected field of the emulator session.

Note:  This option is available only for 5250 sessions.

Cut/Copy Options
You can control the size of the copy area and how +/- signs behave with signed numeric fields (5250 only).

Only if a trim rectangle is marked

Select this box if you want to copy only the trim rectangle that has been marked on the session screen. 

The default is to copy the entire screen if no rectangle is marked.

Autocopy

This option enables you to automatically copy the selected text to the clipboard. When an existing 

selected area is moved to another screen area, the text inside the new selected area is automatically 

copied to the clipboard.

Force Leading +/-

On a signed numeric field, the Force Leading +/- option will force the +/- sign to be at the beginning of 

the field rather than at the end.

Note:  This option is available only for 5250 sessions.

Trim Options
You can control the behavior of the trim rectangle.

Classic Box Style

This option allows you to draw a normal box like Trim Rectangle.

Trim Rectangle sizing handles

Check this box to add "handles" to the trim rectangle, allowing you to modify the size.
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Trim Rectangle remains after edit function

This option keeps the trim rectangle active after completing the trim.

Expand Trim Rectangle during drag

This option causes the trim rectangle to step to character boundaries while it is being sized.

Use solid Trim Rectangle

This option changes the appearance of the trim rectangle. Instead of the standard outline boundary, the 

trim area appears as a solid box.

Windows Style

This option allows you to make uneven selection in the PS. When this option is selected, solid Trim 

rectangles without sizing handles are drawn by default.

Note:  Undo functionality under the Edit menu is disabled for this functionality.

Editing by Linking to Windows Application Programs
Linking to Windows®  application programs supporting Paste Link  lets you paste session-window data to the 

windows of those application programs. You can run Copy Link  when DDE/EHLLAPI is usable.

Confirming the DDE/EHLLAPI Settings
To check whether DDE/EHLLAPI is currently set to usable status, do the following:

1. Click Settings →  API.

2. Make sure the DDE/EHLLAPI  check box  is selected.

If the box is checked, DDE/EHLLAPI is set to usable status. Continue to step 4  on page 64.

3. enablingDDE/EHLLAPIIf the box is not checked:

a. Click the DDE/EHLLAPI  check box  and then click OK.

b. Stop and then start your session to enable the new settings.

4. If DDE/EHLLAPI was already set to usable status, select OK.

Using Copy Link and Paste Link

1. Mark the session window  area for which Copy Link  should be issued.

2. Select Copy Link  from the Edit menu.
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If the session window  is already linked with an application program, Copy Link  appears in gray and cannot be 

selected. In this case, force the application program to end the linkage, or stop the application program. Then 

you can select Copy Link.

3. Start the Windows®  application program for the window to which an area should be copied.

4. Specify the location for which Paste Link  should be run.

5. Issue Paste Link  or Paste Special  by using the menu for the application program.

The contents of the marked area are pasted into the specified location in the window of the application 

program.

Copy Link  is now completed.

When the contents of the marked area in the session window  are updated during linking, the contents of the area 

pasted to the window of the linked application program are also updated.

See the online help for more information about the Copy Link and Paste Link functions.

Copying Table Data to a Spreadsheet
You can use the Cut, Copy, Copy Link, or Copy Append  choices in the Edit menu  to copy data in the session window  to 

the window of a Windows®  spreadsheet application program.

To use Copy, select the Paste  or Paste Link  choice in the application program window into which data is to be copied.

Data in the marked area can be copied in the following three data formats, depending on the format supported by the 

spreadsheet for the window to which data is to be copied:

Sylk format

Data format for general-purpose spreadsheets, such as Multiplan

BIFF format

Data format for Microsoft®  Excel

Wk3 format

Data format for Lotus®  1-2-3

Note:  Whether application programs, such as Excel or Lotus®  1-2-3, also support these data formats in 

subsequent versions depends on individual application program specifications.

copyinglines containing only operational signsmarked dataIndividual items of data in tables of the session window  are divided automatically such that they are suitable for 

spreadsheets, and they are copied into individual cells of tables in the application program.

Copying Marked Data without Dividing It into Cells
To paste data in the marked area per line, without dividing it into individual cells, add the following lines to the 

workstation  profile:
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[Edit]
Sylk=N       (If Sylk format data is not divided into cells)
Biff3=N      (If Biff3 format data is not divided into cells)
Wk3=N        (If Wk3 format data is not divided into cells)

Copying Lines Containing Only Operational Signs
If data in the marked area contains signs, such as +, -, =, or |, the signs are regarded as being ruled lines of the table. 

Once they are removed, only numeric data is copied.

Table  10. Table 

Data in Marked 

Area

1 2 3 4

199060 -63 71+58

1991+6969 9080

199271 +8080-30

Table  11. Data Copied to Spreadsheet

1 2 3 4

1990 60 -63 71 58

1991 69 69 90 80

1992 71 80 80 -30

To copy these signs without replacing them with null characters, add the following lines to the workstation  profile:

[Edit]
MaskGridCharacter=N

Copying Data in Cells As Text Data
Data in the marked area is treated as numeric data by default. Therefore, currency symbols, such as $, and 

punctuation marks, such as commas, are removed before copying. To copy data containing such signs and marks as 

text data rather than numeric data, add the following lines to the workstation  profile:

[Edit]
ConvertToNumeric=N

Data in the marked area containing signs and marks is then copied as text data. In addition, all numeric data that 

does not contain signs and marks is also copied as text data.

Transferring Files
Z and I Emulator for Windows  enables the transfer of one or more files between a host system and workstation. You 

can define file transfer options in advance to help you transfer a variety of files quickly and easily.
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Note:

PCT400 was withdrawn from marketing 3/98.

With Z and I Emulator for Windows, you can perform the following file transfer functions:

Send files to the host system

Send files using the Send File to Host  from the Actions  menu; or by clicking the Send  button on the tool 

bar; or, when using 3270 sessions, the SEND command from the DOS prompt.

You can also send files by using an EHLLAPI or DDE application or a macro that invokes file transfer.

Receive files from the host system

Receive files using the Receive File from Host  from the Actions  menu; or by clicking the Receive  button 

on the tool bar; or, when using 3270 sessions, the RECEIVE command from the DOS prompt.

You can also receive files by using an EHLLAPI or DDE application or a macro that invokes file transfer.

Data Transfer

For 5250 sessions, click Transfer  from the Appearance  menu; then select Data Transfer  on the property 

page  with the General  tab. This causes the invoking of data transfer functionality when one of the above 

actions is taken. If Data Transfer  is not selected, normal file transfer is invoked.

Create, test, replace, and delete templates

Create a template to have Z and I Emulator for Windows  automatically generate a workstation  or host 

file name and transfer type when you select a file to be sent or received.

Note:  It is not possible to define a file transfer template with the long file name naming 

convention.

Define transfer types

Define up to 16 transfer types for each host system. Text, binary, and append (except for CICS®) are 

initially set as transfer types.

Select, create, and customize translation tables

Select translation tables to define which translation table is used during file transfer.

Import or export files (PC/3270  only)

Import/Export is an office system communication program and an application program run on the IBM® 

Customer Information Control System (CICS®). The import/export function makes it possible to import 

or export Final Form Text (FFT), Revisable Form Text (RFT), and PC documents.

When you export a file from the host, your workstation  receives the file you exported and an interchange 

document profile (IDP) file. Before you can import a file to your workstation, you need to create an IDP 

file with transmission information.
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Create interactive document profile (IDP) files (PC/3270  only)

An IDP file contains document header information, has the same name as the file to be transferred, and 

has the extension .IDP.

To create an IDP file, select Transfer  from the Appearance  menu.

Note:  When you transfer a file on a Telnet5250 session, you cannot transfer a file that includes FFEF. The 

current version of the iSeries™, eServer™  i5, or System i5™  Telnet program misinterprets FFEF in the file as an 

end-of-record marker.

ASCII Host Data Transfer
When you are transferring files between two computers, specific protocols must be followed. Files can be transferred 

only when your PC uses the same protocol as the host. Z and I Emulator for Windows  supports the XMODEM and 

YMODEM public domain protocols.

For XMODEM, Z and I Emulator for Windows  uses the XMODEM and XMODEM1K protocols. XMODEM is a block-

oriented, error checking protocol that is a single file, half duplex protocol. XMODEM1K is the same as XMODEM, 

except that it uses larger 1024 byte (1K) packets.

The YMODEM protocol is similar to the XMODEM1K protocol in that it transfers data in 1K packets, but it also allows 

multiple files to be sent in one transfer.

The YMODEMG protocol transfers multiple files like YMODEM, but performs no error detection or error correction. It 

can be much faster than YMODEM, but requires an error-free data connection.

With Z and I Emulator for Windows, you can perform the following data transfer functions to or from ASCII hosts:

Send any type of files to the host system

Send files using the Transfer menu using XMODEM, YMODEM, XMODEM1K, or YMODEMG.

Receive files from the host system

Receive files using the Transfer menu and XMODEM, YMODEM, XMODEM1K, or YMODEMG.

Create, test, replace, and delete templates

Create a template to have Z and I Emulator for Windows  automatically generate a workstation or host 

file name and transfer type when you select a file to be sent or received.

Setting Up the Appearance of a Session Window
You can use the following functions to define the appearance of your session window. These options are in the 

Settings →  Appearance  menu.
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Display Setup

Customize a variety of characteristics, such as the cursor, pointer, rule line, and trimming styles, 

graphics, sound, and color palette, in the display session.

Color Mapping

color mappingSet the colors used in session windows.

Font

fontsChoose the font to use for display session windows, the style, and whether it will be an automatic sizing 

font or a fixed size font. If you use a fixed size font, you can also choose its size. The set of fonts from 

which you can choose depends on the type of display you are using.

Note:  You cannot change the font size when the session window is maximized.

Window Setup

windowsetupChange the appearance and title of the session window and change the session icon.

Sounds
Z and I Emulator for Windows  enables customization of program sounds through the Windows Control Panel. You 

can configure specific program sounds using sound files included with the Z and I Emulator for Windows  product.

A Mute  function can be used to silence all program sounds. This option is available from the Settings →  Appearance → 

Display Setup →  Sound  dialog.

Tool Bar  Setup
The tool bar  displays under the menu bar  in your session window  to allow quick access to the Z and I Emulator for 

Windows  functions, commands, and defined macros.

Use the tool bar  pop-up menu to quickly and easily create, edit, and delete tool bar  items, as well as to save and load 

customized tool bars. When you customize the tool bar, you can change the order of items, add and delete items, 

change the function, title, or graphic associated with any item, change the fonts, colors, and other tool bar  visual style 

elements. The settings are stored in a .BAR file.

To customize your tool bar, select Tool Bar →  Tool Bar Style  from the Settings  menu, or display the Tool Bar  pop-up 

menu by clicking on the right mouse button while pointing at any part of the tool bar.

For information about customizing the tool bar, refer to the online help.

If you want to hide the tool bar, see Showing or Hiding the Menu Bar, Status Bar, or Tool Bar  on page 69.
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Showing or Hiding the Menu Bar, Status Bar, or Tool Bar
You can show or hide the menu bar, status bar, or tool bar. If the menu bar  is displayed, enable or disable status bar or 

tool bar from the session View  menu. You can also do the following:

• Click the upper left corner of the session window  to display the system menu.

◦ Hide Menu Bar  appears when the menu bar  is shown.

◦ Show Menu Bar  appears when the menu bar  is not shown.

◦ Hide Status Bar  appears when the status bar is shown.

◦ Show Status Bar  appears when the status bar is not shown.

◦ Hide Tool Bar  appears when the tool bar  is shown.

◦ Show Tool Bar  appears when the tool bar  is not shown.

◦ Show Expanded OIA  appears when the expanded OIA is not shown.

◦ Hide Expanded OIA  appears when the expanded OIA is shown.

◦ Hide Quick Connect Bar  appears when the Quick Connect bar is shown.

◦ Show Quick Connect Bar  appears when the Quick Connect bar is not shown.

• To hide the menu bar, status bar, tool bar, or expanded OIA, select Hide Menu Bar, Hide Status Bar, Hide Tool 

Bar, Hide Expanded OIA, or Hide Quick Connect Bar.

• To show either the menu bar, status bar, tool bar, or expanded OIA, select Show Menu Bar, Show Status Bar, 

Show Tool Bar, Show Expanded OIA, or Show Quick Connect Bar.

Window Setup
For some Windows®  operating systems, if you clear the Maximized Style →  With Title Bar  option in the session 

Settings →  Appearance &rarrow; Windows Setup  dialog, then the Minimize All Windows  option on the Microsoft 

Windows®  taskbar may not have any effect. To minimize the window, press Alt-Space and click Minimize.

Customizing the Color Mapping using a configuration File
This feature enables users to apply the color mapping configuration to a session using a color mapping configuration 

file (CMP). You can import, modify and save the color mapping configuration in a CMP file, and can also customize 

the "Default" color mapping configuration for all the profiles using the default color mapping configuration file 

(‘DefaultColorConfig.CMP’).

The colors of the various parts of the host-session window can be customized; each component has its own default 

foreground and background colors, which are determined by the attributes (base or extended) sent to the screen by 

the host application to which the session is connected.

Use the Category tree control to change a category, or place your mouse pointer on the section of the Presentation 

Space screen you wish to change the color for and click the left mouse button. On the Color Mapping tab, this will set 

the correct Category/Element, as well as the current colors for that field in the color pulldowns and the Sample text.

The color modification pulldowns give 16 basic colors, each with a name and a color preview. Click the right-hand 

button to open up the standard Windows color palette, where you can further modify the colors.
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How to Enable/Disable the creation of CMP
The ‘EnableCMP’  parameter in the Color section of pcswin.ini, can be set to ‘Y’ or ‘N’ respectively to enable or disable 

the creation of Color Mapping files.

For Example:

[Colors] 
 
EnableCMP=Y 

When enabled, the Color mapping dialog will have four additional options in the ‘File' menu:

1. Open -> Imports the color mapping changes from the selected color mapping file (.CMP) to the current 

session.

2. Save -> Saves the changes made by the User to the currently imported or the associated color mapping file.

3. Save as-> Copies the color mapping configuration set in the color mapping dialog to a new file.

4. Exit -> Exits the color mapping dialog.

This feature enables users to apply the color mapping configuration to a session using a color mapping configuration 

file (CMP). You can import, modify and save the color mapping configuration in a CMP file, and can also customize 

the "Default" color mapping configuration for all the profiles using the default color mapping configuration file 

(‘DefaultColorConfig.CMP’).

The colors of the various parts of the host-session window can be customized; each component has its own default 

foreground and background colors, which are determined by the attributes (base or extended) sent to the screen by 

the host application to which the session is connected.

Use the Category tree control to change a category, or place your mouse pointer on the section of the Presentation 

Space screen you wish to change the color for and click the left mouse button. On the Color Mapping tab, this will set 

the correct Category/Element, as well as the current colors for that field in the color pulldowns and the Sample text.

The color modification pulldowns give 16 basic colors, each with a name and a color preview. Click the right-hand 

button to open up the standard Windows color palette, where you can further modify the colors.

Default Color Settings
If a user has enabled this function and needs to apply the "Default" color mapping configuration to all sessions, the 

'DefaultColorConfig.CMP'  file should be saved to the ZIEWin Application Data folder (based on type of installation). To 

make a new default color mapping configuration file, rename any "*.CMP" file to 'DefaultColorConfig.CMP'.

If a session does not have a Color Mapping file associated with it, the color mapping configuration from 

'DefaultColorConfig.CMP'  would be used by default. If the session already has a CMP file connected with it, the color 

mapping configuration in the CMP file will override the 'DefaultColorConfig.CMP'  configuration.

For Example:
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If a user has a Color mapping file associated with their session profile's file then the color mapping file would take 

priority over the 'DefaultColorConfig.CMP'  file file in terms of keyword precedence.

Session Profile file name:  ABC.WS

Color mapping file:  ABC.CMP (associated with the session profile) has content as below:

[Colors] 
 

BaseColorNormalUnprotected=24D830 000000

DefaultColorConfig.CMP  have below contents:

BaseColorIntensifiedUnprotected=F01818 000000
BaseColorNormalUnprotected= F01818 F01818

The Session profile (ABC.WS) will read the value of BaseColorNormalUnprotected  from the 'ABC.CMP' file and 

BaseColorIntensifiedUnprotected  from the 'DefaultColorConfig.CMP' file.

Note:

1. If this feature is enabled, the colors in Session Profile file will be ignored.

2. The "DefaultColorConfig.CMP"  has colors that users can set for all their session profile files. This 

could be different from the product default colors.

3. The "DefaultColorConfig.CMP"  file needs to be created manually by the user. This does not get 

created automatically by the system.

Migration of Color mapping content
When a User enables this feature and launches a session, the color mapping configuration from the Session profile 

file (if it exists) is migrated once to the Color Mapping file.

Note:  A single Color mapping file may be associated with several profile files. The color configuration of the 

last migrated profile will be stored in the common color mapping file.

When a User disables this feature and launches a session, the color settings from the Color Mapping file are migrated 

once to the Session profile file.

For Example:

Before Enabling this feature, the content in a Session profile has a Color section and a few colors customized in it:

Session Profile file name:  ABC.WS

[Colors] 
 

BaseColorNormalUnprotected=24D830 000000
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After the user enable this feature, if there is no color mapping file associated with the session profile name then 

a new color mapping file will be created with the same name as the session profile file and will copy the color 

configuration to the newly created color mapping file.

File Name:  ABC.CMP

 

BaseColorNormalUnprotected=24D830 000000

The Colors will not get deleted from the session profile name but it will be ignored.

Setting Up and Using the Assist Functions
The auxiliary functions described in this chapter let you operate the system more efficiently. Keyboard/Macro/Script 

Function  can be customized from the Actions  menu. The other functions can be customized from the Edit  menu.

Keyboard, Macro, and Script Functions
A Keyboard/Macro/Script Function command lets you run scripts, macros or Z and I Emulator for Windows-supplied 

key functions without using the keyboard. Run the scripts, macros or key functions from the current cursor position in 

the session window.

Scripting Functions
You can write, execute, record and terminate VBScripts in the emulator environment. These scripts have access to the 

HACL automation API. The programming environment includes methods, class descriptions and properties. VBScript 

is a subset of the Visual Basic®  programming language.

Macro Functions
A macro is a sequence of key or mouse actions and host commands that you can perform with a single action, such 

as a keystroke. Before you can use a macro function, you need to define it. For more information, see Macro/Script 

Setup and Use  on page 76.

Key Functions
Z and I Emulator for Windows  provides many key functions that can be assigned to the keys on the keyboard, the 

mouse buttons, or the buttons of the pop-up keypad. You can also use them to generate macros.
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Hotspot Setup
A hotspot  is an area of the session window  on which you can double-click the left mouse button to perform a 

command or function. You do not need to use the keyboard. For example, you can double-click a function key number 

to perform the function.

Tip:  Select Show hotspots  to get three-dimensional (3D) hotspots; these only require a single click, and they 

stand out on your screen.

You can define the following actions for a hotspot:

• Click on a URL to connect to a World Wide Web site.

• Simulate function keys.

• Play a macro that has the same name as the character string you select on the session window.

• Enter the selected string at the cursor position.

• Simulate the Enter key at the cursor position.

• For VT, simulate two sets of function keys, PF1 through PF4 and F6 through F20.

Using Hotspots

Note:  You must have a mouse to use hotspots

To use a hotspot:

1. Move the mouse pointer to the hotspot displayed in the session window.

2. Double-click the left button of the mouse, except for 3D hotspots, which only require a single click.

Z and I Emulator for Windows  determines whether you have specified a hotspot function that matches what 

appears at the position of the mouse pointer. If so, it processes the hotspot. When two or more hotspots are 

specified for a single character string, the first retrieved hotspot  is processed.

Hotspots are retrieved in the following order:

a. Point-and-select (connect to Web site using URL)

b. PFnn, FPnn, Fnn, nn

c. Point-and-select (run the macro)

d. Point-and-select (enter the selected string)

e. Point-and-select (enter at the cursor position)

types ofhotspots

Keyboard Setup
Keyboard Setup
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You can use Keyboard Setup to modify the function defined for each key on the keyboard, except some reserved keys.

You can define the following functions for the keys.

• Performing a key function

• Playing a macro

• Entering characters

Note:  By default, the Enter function is assigned to the Ctrl key. To change this assignment or, if the Enter key 

does not work properly, you need to customize your keyboard. For 3270 and 5250 sessions, you can use the 

keyboard map files provided with Z and I Emulator for Windows. Refer to Emulator User's Reference  for more 

information about keyboard mapping and functions.

Keyboard File
When you specify a key, you can save the new keyboard layout in a file (.KMP). If you create two or more keyboard 

files, you can alternate between them as required.

To assign a function to a key on the keyboard:

1. Select Keyboard  from the Settings  menu  or click the map icon on the tool bar.

2. When the Keyboard Setup window appears, select Customize.

Note:  Select Spain  from the Language menu  during keyboard setup if you want Catalan support.

3. Assign the key functions, referring to the online help for detailed instructions.

4. Save your changes and exit the Customize Keyboard window.

5. Select OK  after completing the setup.

You can reset either the entire keyboard or specific keys to defaults:

• To reset the entire keyboard, set the current keyboard to  Default  in the Keyboard Setup window.

• To reset specific keys, select a key in the Customize Keyboard window and then select Default  from the 

Current Actions for Selected Key box.

Note:  There are seven keys that you cannot redefine and they are gray or dimmed in Keyboard Setup; these 

keys are: Alt, AltGr, Print Screen, Scroll Lock, CapsLock, NumLock, and Shift.

Customizing the VT Emulator Keyboard
If you are using a VT emulator session, you can represent ASCII control characters in the character strings that you 

define for your customized keyboard.
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Use the # character to represent the CTRL key, following it by any character from the following list (only upper-case 

alphabetics are allowed):

@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_

Use ## to represent an actual #. For example, 123##45  represents 123#45.

If you follow # with any other character than those shown, you will get an error message:

PCSKBD160 - Unrecognized key-action: "character string

For example, the error for the string "#a is

PCSKBD160 - Unrecognized key-action: "#a

The set of control characters is as follows:

Character pair Control Notes

#@ Control-@ NULL

#A Control-A

through

#Z Control-Z

#[ Control-[ ESC

#\ Control-\

#] Control-]

#^ Control-^

#_ Control-_

Because the *.KMP file can be edited, there is a run time check to ensure that the character string is correct. If "### 

is processed, then #  will be displayed, followed by a beep to signify that the entire character string was not played. If 

"123#a456  is processed, then 123  will be displayed, followed by a beep.

Macro/Script Setup and Use
A macro is a sequence of key or mouse actions and host commands that you can perform with a single action, such 

as a keystroke. You can edit an existing macro or create a new macro by selecting Macro/Script  from the Appearance 

menu.

A script is a VBScript program that is a subset of the Visual Basic®  programming language. For information on 

VBScript, see the online help pages.

Using a Macro or Script
You can use a macro or script in various ways. Table 12: Macro Use Examples and Settings  on page 77 lists 

examples of how you can set up and then use macros and scripts.
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Table  12. Macro Use Examples and Settings

If you want to... Do this...

Automatically play a macro or script when your session starts. Set an Auto-Start Macro/Script.

Play a macro or script while attached to a host application. Start Playing Macro/Script.

Play a macro or script with the keyboard or macro function. Use the Keyboard/Macro/Script Function.

Click on a hotspot to play a macro or script. Set a Hotspot.

Assign a macro or script to a pop-up  keypad button. Customize the Pop-Up Keypad  file.

Press the mouse button to play a macro. Customize a Mouse  file.

Press a key on the keyboard to play a macro or script. Customize a Keyboard  file.

Creating a Macro
You can create a macro manually or by recording some of your interactions with the host system, such as your logon 

procedure.

MacrocreatingTo create a macro manually:

1. Macro/Script  from the Appearance  menu.

2. When the Macro/Script Setup window appears, select Customize.

3. When the Customize Macro/Script window appears, select File, then New, then Macro, and edit the macro. 

You can type statements directly or select functions, characters, or even other macros, from the list of Key 

Actions in the Select a Key-Action  subpanel.

Refer to the online help for detailed information.

4. Click File, then Save  to save the macro file.

Note:

1. Macros that are converted to XML are intended for use in ZIEWeb (Z and I Emulator for Web) and will 

not function in Z and I Emulator for Windows  emulation sessions. Use the ZIEWeb Macro Manager to 

import a converted Z and I Emulator for Windows  macro into ZIEWeb. These converted macros will 

not appear in the list of available Z and I Emulator for Windows  macros.

Macro Statements
You can use the following statements when you create a macro:

Key function

Use Z and I Emulator for Windows-supplied key functions
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Macro

Define a macro within another macro but you cannot create a macro in a permanent loop where the first 

macro is repeatedly called at the end of the macros.

Character

Use any characters in the Character  list in the Customized Macro window.

Character string

Use character strings you can type from the keyboard. You must use a double quotation mark (“) at the 

beginning of the character string.

Wait condition

Specify wait conditions to stop the process until the specified time has elapsed or the status satisfying 

the specified condition occurs.

Tokens

You can use tokens, such as goto and run, to add logic.

Macro Loop Considerations
If you use a GOTO and a label in a macro to create a loop, you may experience unpredictable behavior if that loop 

executes a large number (more than 1000) of iterations.

Creating a Script
You can create a script manually or by recording some of your interactions with the host system, such as your logon 

procedure. Scripts, however, allow a higher level of programming control unavailable with macros.

To create a script:

1. Macro/Script  from the Appearance  menu.

2. When the Macro/Script Setup window appears, select Customize.

3. When the Customize Macro/Script window appears, select File, then New, then Script, and edit the script. The 

Select a Key-Action  subpanel, in gray, is not available for creating scripts.

Refer to the online help for detailed information.

4. Click File, then Save  to save the script file.

Configuring a Macro or Script to Autostart
To configure a macro or script to autostart, do the following:

1. Click Settings →  Macro/Script.

The Macro/Script Setup window appears.
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2. Set a macro or script to autostart when your workstation  starts.

3. Refer to the online help for detailed instructions and then select OK  after completing your setup.

Auto-start macro support
To specify which macro should be started automatically after start of a session, add the PCSWS option /

M=<mymacro>, where <mymacro> is the name of the Z and I Emulator for Windows  macro or script file. See the 

following example:

C:\ZIEWin\PCSWS.EXE C:\AppData\LAN1.WS /M=mymacro 

If the specified macro or script does not exist, the following error message will be returned:

PCSKBD400- 

The file: <macro name> is not a Z and I Emulator for Windows  macro/script-file

Configuring a Java Applet to Autostart
To run a Java applet automatically, you can add the function Run Applet  to a macro. You can add this function to an 

autostart macro, so that an applet can be run at session startup.

1. Click Settings →  Macro/Script.

The Macro/Script Setup window appears.

2. Select Run Applet  from the Function drop-down list and type the name of the class.

Refer to the online help for syntax and detailed instructions.

Note:  The applet class specified must exist in the same directory path as the .WS file in which the macro is included.

Recording Macros or Scripts
To start macro or script recording, use the following procedure:

1. Click Start Recording Macro  from the Actions  menu.

2. Type the macro or VBScript name.

3. Select the record format.

If you are recording a macro format file for Express Logon, select the Enable  check box and enter the Express 

Logon Feature (ELF) Application ID.

4. Configure the other options and click OK.
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Note:  When recording a macro, the processing of a nondisplayable field is controlled by the setting of the 

parameter HideNonDisplayDataOnRecord=Y in the [Keyboard] stanza of the .WS file. The hidden fields are 

ignored during the recording session.

To cancel macro or script recording, click Actions →  Cancel Recording Macro. The recording operation is canceled, 

and the macro or script is not saved.

To pause macro or script recording, click Actions →  Pause Recording Macro. The recording operation stops. To 

restart recording, click Resume Recording Macro.

To end macro or script recording, click Actions →  Stop Recording Macro. Recording ends and the macro is saved in 

the specified file.

Playing Macros and Scripts
To play a macro or script, click Actions →  Start Playing Macro/Script, select the macro or script, and click OK. The 

selected macro starts to play.

stoppingmacro playingTo stop playing a macro or script , click Actions →  Quit Playing Macro/Script. The macro or script stops playing.

Note:  Z and I Emulator for Windows  macro files more than 32KB in size cannot be played in the Z and I 

Emulator for Windows  emulator session. If you want to play a macro file that is greater than 32KB, you will 

have to break the macro into multiple files.

Note:  When playing a macro, the processing of a non-displayable field is controlled by the setting of the 

parameter HideNonDisplayDataOnRecord=Y in the [Keyboard] stanza of the .WS file; setting this causes a 

pop-up window to display, requiring your input. When this appears, type in the requested information and 

press Enter  to continue.

ThisMacroName support
The ThisMacroName property is used to enable a running script to obtain the name of the macro file that is running. 

This is useful when writing a script that will be using the name of the macro file.

See the following example of ThisMacroName:

[ZIEWin  SCRIPT HEADER]
LANGUAGE=VBSCRIPT
DESCRIPTION=Example of usage of property ThisMacroName
[ZIEWin  SCRIPT SOURCE]
OPTION EXPLICIT
Dim sName, sHandle
 

REM App Main
Main
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sub Main()
 'Initialize the session
 autECLConnMgr.autECLConnList.Refresh 
 sName = autECLConnMgr.autECLConnList(1).Name
 sHandle = autECLConnMgr.autECLConnList(1).Handle
 

 'Connect to the current session
 autECLSession.SetConnectionByName(ThisSessionName)
 sName = autECLSession.Name
 sHandle = autECLSession.Handle
 

 MsgBox("The current session name :")
 MsgBox(ThisSessionName)
 MsgBox("The macro name is :")
 'Should pop up correct macro file name in the message box
 MsgBox(ThisMacroName)
end sub

Express Logon Feature
The Express Logon Feature (ELF) allows a Z and I Emulator for Windows  TN3270E user to logon to a host application 

without sending the user ID and password. This function is designed to be implemented only in certain circumstances 

by administrators of Z and I Emulator for Windows. Refer to Administrator's Guide and Reference  for detailed 

information on implementation.

Recording an Express Logon Macro
To record an ELF macro, do the following:

1. Choose Actions  from the WorkStation-window menu-bar.

The Actions pull-down menu appears.

2. Choose Start Recording Macro  from the menu.

The Record Macro/Script As  dialog-box is displayed.

3. Select the format of file to be recorded: VBScript or Plain text Macro, if you are recording an Express Logon 

Feature macro.

4. Select the Record User Wait Time to be used. This affects only unconditional wait statements. There is no 

change for the interval in conditional wait statements (interval with condition). For these statements the 

interval is a time-out value, processing normally continues when the condition is satisfied. In most cases the 

script will fail if the time-out value expires before the condition is satisfied.

• Actual- the default no change to existing function.

• None - unconditional wait statements will not be written to the macro/script file. You have to edit the 

script and add any required unconditional wait statements where they are needed.

• Fixed - unconditional wait statements will be written to the macro/script file with a fixed wait time of 

25 ms. You may edit the script file and either increase the time interval or remove the wait statement if 

it not needed.

5. Type the name of the file in which you want to save the macro.
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6. If you are recording an Express Logon  Macro, select the Enable  check box and enter the Express Logon 

Feature (ELF) Application ID.

7. Click OK.

The Record operation starts. In the Actions menu, Start Recording Macro/Script is changed to Stop Recording 

Macro/Script; Pause Recording Macro/Script and Cancel Recording Macro/Script are added.

8. Record the keystrokes.

• If, while you are recording, you choose Cancel Recording Macro/Script:

The Record operation is canceled and nothing is saved. Cancel Recording Macro/Script and Pause 

Recording Macro/Script are removed from the pull-down list. Stop Recording Macro/Script is changed 

to Start Recording Macro/Script.

• If, while you are recording, you choose Pause Recording Macro/Script:

The Record operation is paused and Pause Recording Macro/Script is changed to Resume Recording 

Macro/Script.

• If you choose Resume Recording Macro/Script:

The Record operation is resumed and Resume Recording Macro/Script is changed to Pause Recording 

Macro/Script.

9. When you want to end the recording, choose Stop Recording Macro/Script.

The Record operation stops and the macro is saved in the file you named. Stop Recording Macro/Script is 

changed to Start Recording Macro/Script. Cancel Recording Macro/Script and Pause Recording Macro/Script 

are removed from the list.

Verifying an Express Logon Feature Macro
You can visually inspect an existing Macro recording of a host application logon to verify that the UserID and 

Password have been replaced by Express Logon Feature (ELF) tags. The procedure is as follows:

1. From the Action Bar, open the Macro file containing the recorded keystrokes by selecting Settings > Macro/

Script.

2. Select the Macro file to be inspected and then select Customize.

3. Verify that the UserID has been replaced with two tags: the ELF Application ID and the ELF UserID placeholder. 

The Application ID tag consists of the following three words, each separated by a blank character: "elf", 

"applid", and the identifier of the host application that will be logged onto. The UserID placeholder is )USR.ID(.

For example

"myUserID

should have been replaced with

")USR.ID(

4. Verify that the Password has been replaced with the ELF Password placeholder tag )PSS.WD(.

For example

"myPassword

https://www.ibm.com/docs/en/SSEQ5Y_15.0.0/info_docs/express2.html
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should have been replaced with

")PSS.WD(

5. Verify below entry must be available

For Example:

• For Plain Text macro : elf applid TSOIPO1

• For VBSCript macro : autECLSession.SetELFApplID " TSOIPO1.

Updating an Existing Macro for Express Logon
You can manually update an existing Macro recording of a host application logon to use the Express Logon Feature 

(ELF). The procedure is as follows:

1. From the Action Bar, open the Macro file containing the recorded keystrokes by selecting Settings > Macro/

Script.

2. Select the Macro file you just recorded and then select Customize.

3. Replace the UserID recorded in the Macro with two tags: the ELF Application ID and the ELF UserID 

placeholder. The Application ID tag consists of three words, each separated by a blank character: "elf", 

"applid", and the identifier of the host application that will be logged onto. The UserID placeholder is )USR.ID(.

For example, replace

"myUserID"

with

")USR.ID("

4. Replace the Password recorded in the Macro with the ELF Password placeholder tag )PSS.WD(.

For example, replace

"myPassword"

with

")PSS.WD("

5. Add below new entry to convert Normal macro into ELF macro:

For Example:

• For Plain Text macro : elf applid TSOIPO1

• For VBSCript macro : autECLSession.SetELFApplID " TSOIPO1".

Mouse Setup
The Mouse Setup  command lets you allocate functions to the right and left buttons of the mouse; this enables you to 

perform the following actions without having to use the keyboard:
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• Running the Z and I Emulator for Windows-supplied key functions

• Running the user-defined macros

• Placing a character at the current cursor location

Mouse File
The user can save the functions defined for the mouse buttons in a mouse file (*.MMP). The user can create two or 

more mouse files and switch between them as required.

To set up the mousesetting upthe mouseand assign functions to the mouse buttons:

1. Select Mouse  from the Settings  menu.

The current settings appear in the Mouse Setup window.

2. Set up the required items, referring to the online help for detailed instructions.

If the user want to create or edit a mouse file:

a. Select Customize.

b. When the Customize Mouse window appears, allocate functions to the right and left buttons of the 

mouse. These appear in Current Action for Mouse Button.

c. Select the required functions from List of Key Actions.

d. Save your changes and then select OK.

3. Select OK.

The mouse setup is complete.

Mouse Wheel Functionality
Mouse wheel scroll up and scroll down is mapped to the “PF7” and “PF8” function key (aid key) respectively for 3270 

host.

Mouse wheel scroll up and scroll down is mapped to the “Roll Down” and “Roll Up” function key (aid key) respectively 

for 5250 host.

Using the mouse wheel scroll option, users can scroll up and down on the Mainframe green screen, in case if the host 

data exceeds more than one screen.

Example: User can scroll on z/OS syslogs.

Pop-Up Keypad Setup
pop-up keypadsetup

The pop-up  keypad is a small window in which some buttons are arranged. To display the pop-up  keypad, put the 

pointer anywhere in the session window  and press the right mouse button.

You can allocate the following functions to these buttons:
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• A standard key function provided by Z and I Emulator for Windows

• A user-specified macro

• A character entry

To perform these functions, you only need to click a button on the pop-up  keypad with the left mouse button.

To view the description of a short-name key function or macro, click the right mouse button while pointing at one of 

the function or macro names.

Pop-Up Keypad File
You can specify the number of buttons displayed in the pop-up keypad, the functions allocated to those buttons, and 

colors of the buttons. You can save the specified pop-up keypad contents in a pop-up keypad file (also referred to as a 

poppad  file).

A pop-up keypad file (*.PMP) contains the information for the number of buttons displayed in the pop-up keypad, the 

functions allocated to those buttons,poppad colorand color information. You can define which pop-up keypad file is allocated to 

the pop-up keypad.

Using the Pop-Up Keypad
To use a pop-up keypad:

1. With the mouse pointer anywhere in the session window, click the right mouse button.

2. Select Pad 1, Pad 2, Pad 3, or Pad 4.

3. Click the required button in the pop-up keypad.

To set up the pop-up keypad:setting upthe pop-up keypad

1. Select Popup Keypad  from the Settings  menu.

2. When the Popup Keypad Setup window  appears, set the required items, referring to the online help for detailed 

instructions.

If you want to edit the pop-up keypad file, select Customize  and then make your changes.

3. Select OK. The pop-up keypad you selected is ready for use.

Tab Setup (VT only)
Tab Setup allows you to define tab stops for your VT sessions.

Web Browser Setup
Web Browser Setup allows you to define a preferred web browser and to use it rather than the one that comes with 

your operating system.
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Managing Emulator Sessions
Z and I Emulator for Windows  provides the following functions, in addition to those provided by Windows®, for those 

who work with several open session windows simultaneously. These functions allow you to manage your session 

windows easily and quickly. The Window menu has the following selections:

Jump

Use Jump  to switch between the currently opened session windows.

You cannot use Jump to switch to a session window  that is currently hidden. Instead, select Show 

Session  from the Window menu to display the session window  on the screen. Then, select Jump.

Hide Session

Use Hide Session  to stop displaying a visible session window.

You cannot hide all sessions. At least one session is always shown.

Show Session

Use Show Session  to display a session window  that was previously hidden with Hide Session.

Use the View menu to display a previously-saved arrangement of windows, or to save an arrangement of windows.

Z and I Emulator for Windows  can save and restore the following information relating to the session window  view:

• Position and size of each window

• Window status (standard, minimized, or maximized)

• Window font

You can save view information for up to eight windows.

Getting Help
For more information about managing session windows, refer to the online help:

1. Select Procedures  from the Help menu.

2. When the help window appears, scroll down to Managing Workstation  Windows®.

Select choices from that list for detailed information.

Online Emulator Session
Emulator sessions started from Session Manager online are displayed with “Online” Tag at end of Session Titles. 

Dialogs where create/modify or delete opertations for the .ws (Workstation profile),.bch - (Multiple Sessions or 

Batch),.pmp (Popup-Keypad Configuration).kmp (Keyboard Configuration).bar ( Toolbar Setup), .mmp (Mouse 

Setup) .xlt (Translation Table) are always online



Chapter 3. Using Z and I Emulator for Windows

Detect and Repair
The user use the Help →  Detect and Repair  function to check the Z and I Emulator for Windows  product integrity. 

The Detect and Repair operation performs a check on the installed Z and I Emulator for Windows  files to determine 

whether the installation has been damaged. A subsequent repair is performed, if necessary.

Note:  The user must stop all active sessions before starting the Detect and Repair function.

Check Restore my shortcuts  if the user want original shortcuts restored. If the user have modified shortcuts since the 

original Z and I Emulator for Windows  installation, the user might want to keep your shortcuts intact—in that case, do 

not choose this option.

In order to use the  Detect and Repair  function, the user must be authorized in the System Policy. The user might be 

prompted to provide the original Z and I Emulator for Windows  installation source.

Z and I Emulator for Windows  Detect and Repair  is invoked from the Session Manager or from an emulator session 

window. Windows Installer repair of the Z and I Emulator for Windows  product is invoked from the Windows®  Add/

Remove Programs function. Note the following differences in the operations.

Z and I Emulator for Windows  Detect and Repair performs the following operations:

• Reinstalls a file if it is missing or corrupt, or if it is an older version.

• Rewrites all registry settings for the application in the LOCAL_MACHINE section of the registry.

• Rewrites all registry settings for the application in the CURRENT_USER section of the registry.

• Reinstalls all shortcuts (optional).

Alternatively, Windows Installer performs the following operations:

• Reinstalls a file if it is missing, or if it is an older version. Windows Installer does not check files for corruption.

• Rewrites all registry settings for the application in the LOCAL_MACHINE section of the registry.

• Rewrites all registry settings for the application in the CURRENT_USER section of the registry.

• Reinstalls all shortcuts. This function is not optional in Windows Installer.

Managed ZIEWIN and Interoperablity
This section provides detailed information about Managed ZIEWin and Interoperabilty between HCL Z and I Emulator 

for Windows and HCL Z and I Emulator for Web Clients.

HCL Z and I Emulator for Windows uses Session Manager Online dialog to provide easy access to workstation 

profiles and batch files on the ZIE Server. With Session Manager Online users can create or start a single or multiple 

sessions and or batch files. Users can create their own profile to the ZIE server and migrate existing files such as the 

workstation profiles (*.WS) and batch files (*.BCH) that were stored on the ZIE Server.

This "How To" document aims to supplement additional detailed information in setting up Managed HCL Z and I 

Emulator for Windows (ZIEWIN) as referenced below.
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Steps to Install Using Managed:

Refer to Planning to Install Z and I Emulator for Windows  on page 25

The steps provided in this document are applicable to all Windows 10 versions which are 64-bit OS level.

Prerequisites :

1. Download a copy of HCL Z and I Emulator for Windows 64-bit base package and HCL Z and I Emulator for 

Windows RP1.zip

2. A HCL Z and I Emulator for Web server is required for the Session Manager Online to work.

3. Create a folder (e.g. MPZiewin) in the ZIEWEB published directory.

4. Unzip and dump the HCL Z and I Emulator for Windows RP1 contents in MPZiewin  folder.

5. Right click the MPZiewin folder > Properties > Sharing > Advance Sharing > Put a check on Share this Folder.

6. Click OK then Close.

7. Repeat steps 5-6 with ZIEWEB folder.

8. Obtain the IP address of the ZIEWEB server and use it at step 2 below.

Follow the steps below in setting up Managed HCL Z and I Emulator for Windows (ZIEWIN):

1. There are two ways to input the ZIE Server configuration details. Choosing to go either way will have the same 

results.

• During the ZIEWIN installation a new panel has been added.
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• Preferences Manager - Click on Start > HCL Z and I Emulator for Windows > Preferences > Advanced

2. Enter the configuration parameters based on the information below:

• Web Server URL : The URL of the Web Server from where HCL Z and I Emulator for Windows fix pack 

file will be downloaded for installation. Installer or fix pack will be installed on the system by "Start or 

Configure Sessions - Online" program.>

• Config Server : URL of the Application Server/Embedded Server, on which interoperability module (.war 

file) is deployed. It can be deployed on the HOD Embedded Server or on any configured Application 

Server.

Example: http://< Application Server IP >/<Configured context root of the application>
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For more details on WAR file deployment, refer to the technote <hyper-link>.

• Config Server Port : Port number of Application Server where interoperability module (.war file) is 

deployed.

Example: 9080

3. Click OK.

4. Open File Explorer > This PC > Map network drive.  Use the IP address of the Web Server along with the folder 

where the HCL Z and I Emulator for Windows RP1.msi is located. E.g. \\192.168.56.102\MPZiewin

5. Click Save.

6. Repeat steps 4-5 with ZIEWEB folder. E.g. \\192.168.56.102\ZIEWEB

Note:  This completes configuring Managed HCL Z and I Emulator for Windows (ZIEWIN).

7. To validate that the configuration is correct, create a new Username or use an Existing User in the Session 

Manager Online. Click on Start > HCL Z and I Emulator for Windows > Start or Configure sessions - Online

Points to consider:

• When mapping the network drive ensure that client machine and ZIEWEB server is within the same network.

• The Session Manager Online checks for updates at startup. It is essential that HCL Z and I Emulator for 

Windows RP1 is in the ZIEWEB published directory.

Interoperability between HCL Z and I Emulator for Windows and HCL Z and I 
Emulator for Web Clients
The interoperability feature allows the ZIEWin users to use the ZIEWin sessions from other HCL terminal emulator 

clients, such as ZIEWeb and ZIEWeb Client. ZIEWin users can use the “Session Manager Online” utility to store the 

new sessions and migrate the existing sessions to ZIE server, these sessions are then converted to ZIEWeb Session 

formats for the ZIEWeb and ZIEWeb Client usage.
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Note:  Interoperability feature is introduced in ZIEWin 2.1 version.

ZIEWin client communicates with the ZIE server over HTTP/HTTPS connectivity using JSON data format.

The interoperability feature is supported from ZIEWeb v2.1.0.0 & ZIEWeb Client v2.1.0.0 onwards and is applicable for 

3270 Display, 5250 Display, 3270 Printer, 5250 Printer, and VT sessions.

Note:  The session conversion happens only for ZIEWin to ZIEWeb sessions and not vice versa.

When the user stores the ZIEWin sessions using the “Session Manager Online” utility, they are converted to ZIEWeb 

sessions before saving them to the ZIE server . After storing to the ZIE server , users can log in from ZIEWin, ZIEWeb, 

or ZIEWeb Client to work with the stored ZIEWin sessions.

Using ZIEWin Sessions from ZIEWeb and ZIEWeb  Client:

After the ZIEWin sessions are stored in the ZIE server , if any changes are made to the session definition from any of 

the clients, it is saved in the ZIE server . These session changes will be available to ZIEWin users after the next login.

Below is the list of supported parameters as part of the Interoperability feature.

Table  13. List of Supported Parameters for Interoperability

ZIEWIN Parameter ZIEWEB Parameter

Primary Host Name or IP Address Destination Address

Primary Port Number Destination Port

Primary LU or Pool Name LU or Pool Name

Screen Size Screen Size

Host Code-Page Host Code-Page

Auto-reconnect Auto-reconnect

Backup 1 Host Name or IP Address Backup 1 Destination Address

Backup 2 Host Name or IP Address Backup 2 Destination Address

Backup 1 Port Number Backup 1 Destination Port

Backup 2 Port Number Backup 2 Destination Port

Backup 1 LU or Pool Name Backup 1 LU or Pool Name

Backup 2 LU or Pool Name Backup 2 LU or Pool Name

Enable Security Protocol

Workstation ID Workstation ID

Server Authentication Server Authentication

Message Queue Message Queue

Message Library Queue Library

Send Personal Certificate to Server if it is Requested Send a Certificate

Send Personal Certificate Trusted by Server Certificate Source

Send Personal Certificate Based on Key Usage Enable Key Usage

Machine Mode Terminal Type (VT session)
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Table  13. List of Supported Parameters for Interoperability  (continued)

ZIEWIN Parameter ZIEWEB Parameter

AutoWrap AutoWrap (VT session)

Note:  Only the listed parameters will be modified from ZIEWeb / ZIEWeb Client for a ZIEWin profile. If any 

other parameters are updated from ZIEWeb / ZIEWeb Client, there will not be any changes to the ZIEWin 

session. Users should modify the ZIEWin sessions either from ZIEWin or ZIEWeb / ZIEWeb Client at a time 

and should avoid simultaneous modifications from different clients.

Interoperability 2.1.0.0 Configuration Introduction:

ZIEWeb v3.0 (from v2.1.0.0 onwards) introduced interoperability between ZIEWin and ZIEWeb. This allowed ZIEWin 

sessions to be accessed through ZIEWeb and ZIEWeb Client after the session definitions were uploaded to the ZIE 

server .

Password provided during the user creation will be encrypted using AES 128-bit algorithm and will be sent to the 

server through the HTTP/HTTPS protocol as Json object. UID is added to the WS and BCH profile files for unique 

identification. Only Connection parameters are considered for the interoperability between ZIEWin and ZIEWeb Clients 

and vice-versa.

After the ZIEWin sessions are converted and stored in the ZIE server , any changes made to the common parameters 

from any of the clients will be saved on the ZIE server . These parameter changes will be available to ZIEWin users 

after the next login.

Steps to install:

1. Install the ZIEWeb v3.0.

2. Install the ZIEWin v3.0

WAR File Configuration:

The interoperability executable (ZIEWeb_Interoperability.war) is available under the lib directory of the product.

For Embedded Web Server:

If the Embedded Web Server is used, by default Interoperability application is running on context root "interop”. If 

the user needs to change the context root, add the following parameter to the configuration file (config.properties), 

located in the ZIE server publish directory.

Example: InterOpContextPath=interop

The default ZIE server IP is 127.0.0.1 and the ZIE server port is 8999. If the user needs to connect to the ZIE server 

located on a different machine, then override the interoperability configuration by modifying the properties of 

“interop_overrides.xml”  in the conf directory under the lib directory of the product.

Table  14.  List of properties that can be used to configure the Interoperability

Property Value Description

ZIEWEB_SERVER_IP 127.0.0.1 ZIE server address
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Table  14.  List of properties that can be used to configure the Interoperability  (continued)

Property Value Description

ZIEWEB_SERVER_PORT 8999 ZIEWEB Config Server port

Directory_Location C:\\dir_location Directory Location for logs

The user can utilize ZIEWeb_Interoperability.war  file (available under the lib directory of the product) to deploy to 

different application servers such as WAS/Tomcat.

For WebSphere Application Server (WAS):

1. Log in to WebSphere Application Server.

2. Go to Applications.

3. Click WebSphere enterprise applications under Application Type.

4. Select ZIEWeb_Interoperability.war file.

5. Click on Initialize parameters for servlets link under Web Module Properties  section.

6. Enter the required values.

Supported Application Servers: Apache Tomcat and WAS.

Limitations

1. Only connection parameters are considered for interoperability between ZIEWin and ZIEWeb and vice-versa.

2. Session creation from ZIEWeb / ZIEWeb Client will not be converted to a ZIEWin session.

Known Issues

1. For stored ZIEWin sessions, changes to any session parameters (not only the listed parameters) from 

ZIEWeb / ZIEWeb Client will be overridden or set to default when there is an update from “Session Manager 

Online” (ZIEWin Client).

2. If there are simultaneous profile updates from any of the two clients, the most recent update will be saved as 

the final copy in the ZIE server .

3. Modifications done in multiple sessions (add, delete sessions, or rename) from the ZIEWeb Clients do not 

reflect in the ZIEWin Client.

4. Saving/renaming profiles with special characters (Ex: \ / : * ? " < > |.) in ZIEWeb/ ZIEWeb Clients will result in 

unexpected behavior in the ZIEWin Client.

How to setup Managed HCL Z and I Emulator for Windows (ZIEWIN)

HCL Z and I Emulator for Windows uses Session Manager Online dialog to provide easy access to workstation 

profiles and batch files on the ZIE Server. With Session Manager Online users can create or start a single or 

multiple sessions and or batch files. Users can create their own profile to the ZIE server and migrate existing 

files such as the workstation profiles (*.WS) and batch files (*.BCH) that were stored on the ZIE Server.

This "How To" document aims to supplement additional detailed information in setting up Managed HCL Z 

and I Emulator for Windows (ZIEWIN) as referenced below.

Steps to Install Using Managed: Refer to Planning to Install Z and I Emulator for Windows  on page 25
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The steps provided in this document are applicable to all Windows 10 versions which are 64-bit OS level.

Prerequisites :

a. Download a copy of HCL Z and I Emulator for Windows 64-bit base package and HCL Z and I Emulator 

for Windows RP1.zip

a. A HCL Z and I Emulator for Web server is required for the Session Manager Online to work.

b. Create a folder (e.g. MPZiewin) in the ZIEWEB published directory.

c. Unzip and dump the HCL Z and I Emulator for Windows RP1 contents in MPZiewin  folder.

d. Right click the MPZiewin folder > Properties > Sharing > Advance Sharing > Put a check on Share this 

Folder.

e. Click OK then Close.

f. Repeat steps 5-6 with ZIEWEB folder.

g. Obtain the IP address of the ZIEWEB server and use it at step 2 below.

Follow the steps below in setting up Managed HCL Z and I Emulator for Windows (ZIEWIN):

There are two ways to input the ZIE Server configuration details. Choosing to go either way will have the same 

results.

• During the ZIEWIN installation a new panel has been added.

• Preferences Manager - Click on Start > HCL Z and I Emulator for Windows > Preferences > Advanced
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a. Enter the configuration parameters based on the information below:

• Web Server URL : The URL of the Web Server from where HCL Z and I Emulator for Windows fix 

pack file will be downloaded for installation. Installer or fix pack will be installed on the system 

by "Start or Configure Sessions - Online" program.>

• Config Server : URL of the Application Server/Embedded Server, on which interoperability 

module (.war file) is deployed. It can be deployed on the HOD Embedded Server or on any 

configured Application Server.

Example: http://< Application Server IP >/<Configured context root of the application>

For more details on WAR file deployment, refer to the technote <hyper-link>.
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• Config Server Port : Port number of Application Server where interoperability module (.war file) 

is deployed.

Example: 9080

b. Click OK.

c. Open File Explorer > This PC > Map network drive.  Use the IP address of the Web Server 

along with the folder where the HCL Z and I Emulator for Windows RP1.msi is located. E.g. \

\192.168.56.102\MPZiewin

d. Click Save.

e. Repeat steps 4-5 with ZIEWEB folder. E.g. \\192.168.56.102\ZIEWEB

Note:  This completes configuring Managed HCL Z and I Emulator for Windows (ZIEWIN).

f. To validate that the configuration is correct, create a new Username or use an Existing User in the 

Session Manager Online. Click on Start > HCL Z and I Emulator for Windows > Start or Configure 

sessions - Online

Points to consider:

• When mapping the network drive ensure that client machine and ZIEWEB server is within the same 

network.

• The Session Manager Online checks for updates at startup. It is essential that HCL Z and I Emulator 

for Windows RP1 is in the ZIEWEB published directory.

Utilities
Z and I Emulator for Windows  provides the following utilities:

32-bit ODBC Administrator

Allows you to add, configure, or delete an ODBC data source.
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Scratch Pad

The Scratch Pad is a lightweight text editor with the capability of normal edit operations, such as cut, 

copy and paste.

Note that Scratch Pad requires .NET Framework 3.5 or lower versions installed. The menu item is 

grayed out in Windows 8 or 8.1 as .NET Framework 3.5 is not available by default on these operating 

systems. Install .NET Framework 3.5 to resolve the problem.

Multiple Sessions

Provides the capability to run multiple host sessions using a single icon.

ZipPrint

Allows you to print PROFS®  notes, calendars, CMS files, XEDIT workspaces, and 3270 session screens.

Convert Macro

Allows an existing Z and I Emulator for Windows  Macro file to be converted to an XML or VBScript file.

Data Transfer

Transfers data from the iSeries™, eServer™  i5, or System i5™  to your workstation, or from your 

workstation  to the iSeries™, eServer™  i5, or System i5™  (record-level data transfer).

iSeries Connection Configuration

Define connections to each iSeries™, eServer™  i5, or System i5™  host that will use the data transfer 

function.

Preferences

Configuration of certain advanced parameters.

PcsSound

The PcsSound utility, available under the product installation directory, allows you to:

• Assign labels to sound events.

• Associate sound files to sound events.

• Cleanup sound labels from the registry.

• Save the current sound scheme to a file.

• Restore a saved sound scheme.

Note:  Saving and restoring a sound scheme will be useful while changing Windows themes.

32-Bit ODBC Administrator
ODBC is a programming interface that enables applications to access data in database management systems that 

use Structured Query Language (SQL) as a data access standard.
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Use the following steps to set up the Z and I Emulator for Windows  ODBC data source:

1. Select the 32-bit ODBC Administrator  icon from the Windows®  Control Panel. The Data Sources window 

appears.

2. Select IBM®  DB2®  ODBC Driver data source in the Data Sources (Drivers) list. Then click Finish.

3. Click Add Database. The Z and I Emulator for Windows  Add Database SmartGuide appears to prompt you 

through the set up.

4. Select the Manually Configure a Connection to a DB2®  Database  radio button.

5. Specify the information to set up the data source, by clicking Next.

6. When you are finished specifying the information, click Done.

7. You will be prompted to test the connection. To test the connection, click OK.

Note:

1. Z and I Emulator for Windows  uses ODBC 32-bit drivers. Applications, such as Lotus®  1-2-3®  included 

in the Lotus®  SmartSuite®  96 package, require a 16-bit driver and will not work with Z and I Emulator 

for Windows. You should see your product vendor for a version that utilizes 32-bit ODBC drivers (Lotus 

1-2-3®  included in Lotus®  SmartSuite®  97 for example).

Multiple Sessions
The Z and I Emulator for Windows  Multiple Sessions Batch Program enables you to start several host sessions by 

clicking a single icon; the necessary commands are specified in a batch file (.BCH). You can include in a batch file 

other programs, which may communicate with a host session using the DDE or EHLLAPI interface.

ZipPrint
ZipPrint is a 3270 utility that enables you to print PROFS®  notes, calendars, OV documents, CMS files, XEDIT 

workspaces, and 3270 session screens. By default, it uses the Windows®  printer currently set up for the host session, 

but you can change it if you wish.

You do not have to install ZipPrint—you just start it. It adds itself to the menu bar of the sessions for which you define 

it, so you can use it in the same way as any other menu bar function. You must start ZipPrint before you start a 

session in which you want to use it.

ZipPrint needs the DDE/EHLLAPI, so you must make sure that this is enabled for the sessions for which you want to 

use ZipPrint. (It is enabled by default, but you should check that it has not been turned off.)

For more information about ZipPrint, see ZipPrint (3270 Only)  on page 59.
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File Transfer Considerations
ZipPrint uses the Z and I Emulator for Windows  file transfer function to print VM/CMS notes and files. In order for this 

function to work correctly, you should use the VM/CMS host type for 3270 file transfer.

In the emulator session window, click Settings →  Transfer. On the File Transfer Settings →  General  tab, select VM/

CMS  from the Host Type  drop-down list.

On slow communications lines, if you are using a large packet or block size, you may experience a file transfer 

timeout. If you do, you should increase the timeout delay. To change the timeout delay, do the following:

1. From the session menu, click Settings →  Transfer.

2. On the General  tab, change the File Transfer Timeout  to 150 seconds.

Convert Macro
The Convert Macro utility enables you to convert an existing Z and I Emulator for Windows  Macro file to XML or a 

VBScript file.

Note:  Macros that are converted to XML are intended for use in ZIEWeb (Z and I Emulator for Web) and will 

not function in Z and I Emulator for Windows  emulation sessions. Use the ZIEWeb Macro Manager to import 

a converted Z and I Emulator for Windows  macro into ZIEWeb. These converted macros will not appear in the 

list of available Z and I Emulator for Windows  macros.

To use the conversion utility, click HCL  Z and I Emulator for Windows  →  Utilities →  Convert Macro.

To convert an existing macro to XML or a VBScript, do the following:

1. Select the name of an existing macro to be converted.

Note:  The macro must exist in the application data directory specified during installation.

2. Select VBScript  or XML  as the type of macro to which to convert.

3. Click Convert.

4. Enter a name for the new XML file or VBScript or accept the generated name. The extension will be added 

automatically.

Note:  When saving a converted XML macro you can choose where you would like to save it. You 

should not change the location of the converted VBScript macros.

5. Click Save.

6. Repeat the procedure to convert another macro, or click Close  to end the application.
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Data Transfer
Z and I Emulator for Windows  Data Transfer enables you to transfer data between an iSeries™  system and your 

workstation. To use the Data Transfer function, select the Data Transfer  icon.

Transferring data is quite different from transferring files, which is described in Transferring Files  on page 66.

Requirements
Before you can transfer data with Z and I Emulator for Windows:

• IBM®  PC Support/400 (5738-PC1) must be installed on your iSeries™, eServer™  i5, or System i5™, unless 

OS/400®  Version 3 (or later) or i5/OS™  is installed.

Data Transfertypes ofThere are two types of data transfer, depending on the direction of the transfer.

Data sending

Data is transferred from your workstation  to the iSeries™, eServer™  i5, or System i5™.sending data to the hostYou can transfer 

data to any of the following destinations:

• Existing members in an existing iSeries™, eServer™  i5, or System i5™  physical file

• New members in an existing iSeries™, eServer™  i5, or System i5™  physical file

• New members in a new iSeries™, eServer™  i5, or System i5™  physical file

Note:  You cannot transfer data from a workstation  file to an iSeries™, eServer™  i5, or System i5™ 

logical file.

Data receiving

Data is transferred from the iSeries™, eServer™  i5, or System i5™  to your workstation.receiving data from the host

While receiving data from the host, you can specify the data to be received and where the data is to be 

output.

Receivable data includes:

• An entire iSeries™, eServer™  i5, or System i5™  file

• Part of an iSeries™, eServer™  i5, or System i5™  file

• Data combined from several iSeries™, eServer™  i5, or System i5™  files

• Summary of record groups

Specify the following output destinations:

• Display

• Disk

• Printer

Also, you can specify the numeric value format.
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For more information about data transfer, refer to Emulator User's Reference.

iSeries Connection Configuration Utility
The iSeries™  Connection Configuration Utility is used to define connections to each iSeries™, eServer™  i5, or System 

i5™  host that will use the data transfer function. The connection definitions are saved in an .NDC file in ASCII format.

You can use this utility for TCP/IP connections.

For more information on Data Transfer see Data Transfer  on page 99.

To use the utility, click Start →  Programs →  HCL  Z and I Emulator for Windows  →  Utilities →  iSeries Connection 

Configuration; the resulting iSeries™, eServer™  i5, or System i5™  configuration screen has the following options:

Show IP Host Connections

Click this button to display and configure IP connections to the iSeries™, eServer™  i5, or System i5™ 

host.

Add

Click the type of connection and then click Add. Enter the Host name  and Alias  in the resulting dialog 

box.

Modify

Select a host name from the connection list, and then click Modify  to edit the Host name  and the Alias 

in the .NDC file.

Remove

Select a host name from the connection list, and click Remove  to delete this connection definition from 

the .NDC file.

Note:  When disabling a connection, if you want to preserve the connection definition but disable 

the connection, clear the checkbox next to the name in the connection list.

Global Parameters

Click this button to edit the Extension list  and Cache size.

Extension List
The extension list parameter specifies the extension of a file on an iSeries™, eServer™  i5, or System i5™. You can 

specify more than one extension parameter in the extension list. The code pages of files with the specified extensions 

are translated from the EBCDIC code page to the ASCII code page when the file is transferred between the iSeries™, 

eServer™  i5, or System i5™  and the client. Up to three characters are allowed. There are two special cases:

• A dot alone (. ) indicates that data for files having no extension should be converted.

• The character pair .*  indicates that data for all files should be converted.
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Cache Size
The cache size parameter specifies the number of kilobytes of iSeries™, eServer™  i5, or System i5™  data that is 

buffered in the read-ahead cache of the client. The default is 256 KB; the maximum is 4 MB. A value of zero requests 

that no cache be used. iSeries™, eServer™  i5, or System i5™  data can be retrieved in amounts that are first cached 

locally on the client. The client retrieves the data from the cache to populate the local device. This read-ahead caching 

reduces the number of times the client has to access the iSeries™, eServer™  i5, or System i5™  to retrieve the data.

Preferences
The Preferences  utility provides a method for changing configuration and setup items.

Note:

1. Preferences set with the Preferences  Utility pertain to you whenever you log on to the same user ID on 

the affected workstation; they apply to all of your sessions while you are logged on.

2. Preferences set using the session Edit  menu apply to all sessions controlled by the workstation profile 

created or changed while using a session—when that session profile is used again, the preferences 

are applicable, regardless of the user ID at the time.

3. One of the capabilities of the Preferences  Utility is to allow specification of a directory to be used for 

storing your profiles; this allows full control of your environment.

To access the Preferences  Utility, click Programs -> HCL  Z and I Emulator for Windows  -> Utilities -> Preferences 

from the Windows Start  menu. Select the Basic  tab to change the preferences and select Advanced  tab to change the 

maximum number of emulator sessions and pass through host certification validation.

Basic

Emulator Profile File Location
If the All User application data directory location was selected during installation of Z and I Emulator for Windows, 

you can specify the default location of workstation profiles.

Macro/Script Location
You can specify where emulator macro and script files are to be placed. This directory will be common to all sessions.

By default, macros are placed in the application data directory specified during the installation of Z and I Emulator for 

Windows, and the macro/script location field value is blank.
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User Interface Language
You can view the language of the installed package by selecting Help > About Z and I Emulator for Windows  from the 

session menu bar.

If your system was installed with multiple-language support, the Basic  property page  shows a section labeled 

Select a default user interface language. If you click on the radio button for Z and I Emulator for Windows  User 

Interface Language Preference, it also shows a drop-down list box, with the language selected that is currently 

being used; you can select any other language from the list, and that language will be used for the user interface 

when you subsequently restart Z and I Emulator for Windows. Or you can click the radio button User Default from 

Regional Settings  if you want the language to be that specified in the Windows®  settings. You can also click the radio 

button Post a Language Selection Dialog for each process; this results in a pop-up dialog each time you start a new 

application from the Z and I Emulator for Windows  group of programs.

Note:  You might receive a warning message, if the selected language is incompatible with your system's 

current code page. You can ignore this, if you are planning to reboot your computer to select a new system 

locale with a compatible code page.

Advanced

Maximum number of emulator sessions
Specify the maximum number of Telnet emulator sessions. It can be either 26 or 52 sessions. Default is 26 sessions.

Pass Through Host Certificate Validation
Choose whether to enable or disable the default certificate validation process during SSL/TLS handshake. Default is 

enable the certification validation. Applicable only for Microsoft schannel provider.

Note:  By default, schannel (MSCAPI) is responsible for validating the host certificate chain received during 

SSL/TLS handshake. Schannel runs several checks on the received certificate chain, one of which verifies 

that the signature affixed to the certificate is valid. The hash value computed on the certificate contents must 

match the value that results from decrypting the signature field using the public component of the issuer. To 

perform this operation, the user must own the public component of the issuer, either through some integrity-

assured channel or by extracting it from another (validated) certificate. The default certificate validation 

process is exhaustive and runs several checks on the host certificate chain to successfully validate it. Enable 

this option, the user must effectively suppress the default validation done by schannel and the identity of the 

host would not be verified. As we are skipping the host certificate validation, the status bar is updated with 

the following message: “Skip the certificate validation since pass-through host certificate validation option is 

enabled.” Using this option is not recommended.

When the Host certificate is not added to the trusted root and “Pass-Through Host Certificate 

Validation” is enabled, a pop-up is displayed. Users can suppress this pop-up by adding the 
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“SuppressPassThroughPopup=Y” keyword under the “[Security]” section in the pcswin.ini file. By default, 

SuppressPassThroughPopup is disabled.

Configuration of License Manager settings
The License Manager settings can either be configured by providing the required server details in the ‘InstallShield 

Wizard' at the time of ZIEWin installation itself, or can be added/updated in the ‘License Manager Settings' section of 

the Advanced tab within the Preferences.

License Manager settings

• License URL :

Specifies the HTTP URL of the License Manager Server to which the HCL Z and I Emulator for Windows 

session sends the license parameters. It is mandatory to configure this field to use the product. If this field is 

not configured the emulator session initiation will be aborted.

For Example:

http://<appserver-address>:<port-num>/<context-root>/LicenseLogger

where,

◦ <appserver-address>  is the hostname or IP address of the server on which the License Manager is 

installed,

◦ <port-num>  is the port that is specified during the deployment of the application server and,

◦ <context-root>  is the location name that can be configured by the Administrator.

• Interval :

Specifies the time period in minutes, after which the HCL Z and I Emulator for Windows session sends the 

license parameters. It is the request interval after which the server marks the client as timeout if the request is 

not sent. The minimum value is 5 minutes (which is the default), and the maximum value is 30 minutes.

Note:  The License Manager Settings set using the 'Preferences'  utility takes precedence over the 

values set during installation. If the installation is custom 'User Installation' where the application data 

location is %appdata%  in the User directory, the values set in the 'Preferences' utility is applicable only 

for the current user.

1. Configure the License Manager Settings during the GUI installation of ZIEWin

The 'License Manager URL'  and 'Interval'  fields can be set during installation, in the 'License Manager Server 

Details' panel. Users may skip the License Manager configuration at installation time and choose to configure 

it after installation using the 'Preferences' utility.
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Figure :  License Manager Settings section in the ‘Preferences Manager' panel ZIEWin.

2. Configure the License Manager Settings using “Preferences” utility

The 'License URL'  and 'Interval'  fields can be set using the 'Preferences' utility, by entering values to the 

respective fields under the 'License Manager Settings' in the 'Advanced' tab.
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Figure :  License Manager Settings section in the ‘Preferences Manager' panel ZIEWin.

ZIE Server Details
Configuration of ZIE Server details

The ZIE Server can either be configured by providing the required server details in the ‘InstallShield Wizard' at the time 

of ZIEWin installation itself, or can be added/updated in the ‘ZIE Server Detail' section of the Advanced tab within the 

Preferences.

• Web Server Details:  The URL of the Web Server from where Z and I Emulator for Windows installer or fix 

pack file will be downloaded for installation. Z and I Emulator for Windows prompts the user with a Pop-Up 

message for an Auto-Upgrade, if a newer version of ZIEWin is available on the Web Server. Upon receiving a 

confirmation from the user to upgrade, the latest version of installer or fix pack will be installed on the system 

by Z and I Emulator for Windows Session Manager ONLINE.

• Config Server:  URL of the Application Server/Embedded Server, on which interoperability module (.war file) is 

deployed. It can be deployed on the Embedded Server or on any configured Application Server.
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Example: http://< IP >/<Configured context root of the application>

For more information on ZIEWeb - ZIEWin interoperability and common parameters, refer to Interoperability 

between HCL Z and I Emulator for Windows and HCL Z and I Emulator for Web Clients  on page 13

• Config Server Port:  Port number of Application Server where interoperability module (.war file) is deployed. 

Example: 9080.

1. Configure the ZIE Server Settings during the GUI installation of ZIEWIN

During the installation in the “ZIE Server Details” install panel user can configure the “Web Server URL”, “Config 

Server” and “Config Server Port” fields. User may skip configuration during the installation and can configure 

using “Preferences” utility after installation.

Figure :  ZIE Server Details section in the ‘InstallShield Wizard' of ZIEWin.

2. Configure the ZIE Server Settings using “Preferences” utility

In the “Preferences” utility, go to “Advanced” tab to find the section “ZIE Server Details”, user can configure the 

fields “Web Server URL”, “Config Server” and “Config Server Port” here. Please refer to the figure below.
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Figure :  License Manager Server and ZIE Server Details section within the Advanced tab of 

Preferences utility in ZIEWin.

Standby/Hibernate
Choose whether to prompt for acceptance when the system attempts to go to standby or hibernate (power saving) 

mode. If you select Standby/Hibernate without prompting, Z and I Emulator for Windows  allows the system to 

standby or hibernate without prompting you, even if sessions are connected. By default, this option is clear.

See Power Management  on page 51 for more information.

Z and I Emulator for Windows  FTP client
The Z and I Emulator for Windows  FTP client implements the client functionality specified by File Transfer Protocol 

(FTP), which is the standard protocol for transferring files to and from remote machines running FTP servers. The 

FTP client enables file and directory upload and download, and directory navigation of remote and local file systems.

The Z and I Emulator for Windows  FTP client supports the following servers:
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• UNIX

• iSeries (AS/400)

• Windows

• z/OS MVS

• VMS

The following limitations apply:

• Secure connections (SSL/TLS) are not supported.

• The local file list does not support listing multiple local or LAN-attached drives.

To view files on a different drive, type the drive letter of the drive you would like to view in the Directory field 

and click Enter. The new drive is displayed in the local file list.

• Code page conversion for files is not supported.

• Directory transfer is not supported on systems that do not have directory structures similar to Windows and 

UNIX. Such systems include the following:

◦ VM

◦ OS/390 or z/OS MVS services

◦ OpenVMS

◦ i5/OS and OS/400 Library File System

Command Line FTP
The command line FTP is used to achieve the FTP functionality over the command line. It is used to transfer files 

using FTP to and from a host with a UNIX file system, using pcsftpcmd.exe. It can be invoked from the command line 

using a set of parameters and switches. The functions supported by the executable are:

• Download a file

• Upload a file

• Delete a file (host side)

• Create a new directory (host side)

The necessary arguments for invoking the executable are:

hostname

This is the first argument and you need to specify the FTP server host name to which you want to 

connect.

username / password

These are the second and third arguments, which specify the user credentials to access the given host.

operation

In this argument you can specify the operation that needs to be performed. Possible operations are:
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• /d  - This switch is used for downloading a file from the host to the client system. This switch 

should be followed by the local directory where the file needs to be downloaded, a space and the 

complete path of the host file along with the name of the file that needs to be downloaded.

• /u  - This switch is used for uploading a file from the client system to the host server. This switch 

should be followed by the complete path of the local directory along with the name of the file 

that needs to be uploaded, a space and the host directory where the file needs to be uploaded.

• /FILE  - This switch is used to specify that a set of FTP commands are contained in a separate 

file and needs to be executed. This switch is followed by the complete path and the name of the 

file that contains the batch commands.

• MKDR  - This switch is used to create a new Directory at the host. This is followed by the name of 

the directory to be created.

• DELE  - This switch is used to delete a file from the host. This switch is followed by the complete 

path along with the name of the file to be deleted.

The transfer mode is set to AUTOMATIC, that is, the executable automatically checks to see if the extension of the file 

to be transferred is one of .log, .ini, .txt, .bat, .inf, in which case the mode is set to ASCII. For everything else it is set to 

BINARY mode.

Use one of the following switches to invoke help:

• -?

• /?

• -HELP

The issue here is that the password would be in plain text, which would be a security concern which can be overcome 

by requesting the customer to explicitly enter the password when the connection is being made.

The initial command line FTP being developed would entertain non-secure connections alone and would not support 

secure connections. The command line FTP currently under development would support only Windows/Unix style file 

systems. Other file systems would be supported in future releases.

If the user does not want to give the password in plain text along with the other parameters, a - can be entered in the 

password field, and then run the command which asks for the user to input the password dynamically.

The command line FTP is currently available only in English language.

Messages
Online messages are displayed during Z and I Emulator for Windows  sessions, but a message does not always mean 

an error occurred. For example, a message might tell you that an operation is in progress or has been completed. A 

message can also prompt you to wait for the completion of an operation.

Press F1 to display help for the messages that appear.
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Security-Related Messages
Z and I Emulator for Windows  optionally utilizes Transport Layer Security (TLS) or Secure Sockets Layer (SSL) to 

establish sessions with servers; this might require input from you (for example, a password). Refer to Administrator's 

Guide and Reference  for details.

Functions Restricted by System Policies
If your workstation is centrally administered, you may be shown a warning or pop-up error message whenever you 

attempt to use certain restricted functions. For example, if your ability to remap the keyboard is restricted, a message 

would be displayed when you select Keyboard  from the Settings  menu.

Contact your system administrator for further guidance. For further information about the systems policies provided 

with Z and I Emulator for Windows, refer to Administrator's Guide and Reference.

System Error Messages
If a page fault or similar system error message appears in a pop-up window, you can copy its contents into the 

Windows®  clipboard. Use the following procedure:

1. Click Details Command  on the pop-up window.

2. Mark the text that you want to copy.

3. Right click the marked text and then click Copy.

4. Start an editor, such as Notepad, and click Edit →  Paste.

5. Save the file in case an HCL  service representative needs this information to diagnose your problem.

OIA Messages
Z and I Emulator for Windows  displays messages in the operator information area (OIA) or in a pop-up window. 

Messages from Z and I Emulator for Windows  are displayed in the message window; messages from the host system 

are displayed in the OIA of the session window.

The bottom line of the session window  is the OIA. The OIA indicator indicates the status of Z and I Emulator for 

Windows  and information about the workstation, host system, and attachment method.

All of the OIA indicators, reminders, and messages are described in the online help.
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Chapter 4. Notices
This information was developed for products and services offered in the United States. HCL  may not offer the 

products, services, or features discussed in this information in other countries. Consult your local HCL  representative 

for information on the products and services currently available in your area. Any reference to an HCL  product, 

program, or service is not intended to state or imply that only that HCL  product, program, or service may be used. 

Any functionally equivalent product, program or service that does not infringe any HCL  intellectual property right may 

be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-HCL  product, 

program, or service.

HCL  may have patents or pending patent applications covering subject matter described in this information. The 

furnishing of this information does not give you any license to these patents. You can send license inquiries, in 

writing, to:

HCL

330 Potrero Ave.

Sunnyvale, CA 94085

USA

Attention: Office of the General Counsel

HCL TECHNOLOGIES LTD. PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 

EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of 

express or implied warranties in certain transactions, therefore, this statement may not apply to you..

This information could include technical inaccuracies or typographical errors. Changes are periodically made to 

the information herein; these changes will be incorporated in new editions of the information. HCL  may make 

improvements and/or changes in the product(s) and/or program(s) described in this information at any time without 

notice.

Any references in this information to non-HCL  documentation or non-HCL  Web sites are provided for convenience 

only and do not in any manner serve as an endorsement of those documents or Web sites. The materials for those 

documents or Web sites are not part of the materials for this HCL  product and use of those documents or Web sites 

is at your own risk.

HCL  may use or distribute any of the information you provide in any way it believes appropriate without incurring any 

obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of 

information between independently created programs and other programs (including this one) and (ii) the mutual use 

of the information which has been exchanged, should contact:

HCL

330 Potrero Ave.

Sunnyvale, CA 94085
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USA

Attention: Office of the General Counsel

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of 

a fee.

The licensed program described in this information and all licensed material available for it are provided by HCL 

under terms of the HCL  Customer Agreement, HCL  International Programming License Agreement, or any equivalent 

agreement between us.

The performance data discussed herein is presented as derived under specific operating conditions. Actual results 

may vary.licensing agreement

Information concerning non-HCL  products was obtained from the suppliers of those products, their published 

announcements or other publicly available sources. HCL  has not tested those products and cannot confirm 

the accuracy of performance, compatibility or any other claims related to non-HCL  products. Questions on the 

capabilities of non-HCL  products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as 

completely as possible, the examples include the names of individuals, companies, brands, and products. All of these 

names are fictitious and any similarity to actual people or business enterprises is entirely coincidental.
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HCL, the HCL logo, and hcl.com are trademarks or registered trademarks of HCL Technologies Ltd., registered in 

many jurisdictions worldwide. Other product and service names might be trademarks of IBM® or other companies.
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